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1 General note  

1.1 Intended use  
TomoCon PACS is a PACS system intended to be used for patient image data 
storage, handling, transport, visualization and diagnostics. It allows DICOM data 
import and export and visualization of stored images for diagnostic purposes. 

1.2 Safety precautions 
TomoCon user interface is written in English language; therefore the knowledge of 
English on an appropriate level is required. 

The software is running on Microsoft Windows Windows 2000 or Windows XP 
Professional, therefore good knowledge of the used operation system is 
recommended. 

Good understanding of installation instructions in this document (see 2.2 Installing 
TomoCon) is mandatory before installing TomoCon for clinical usage. Good 
understanding of the whole user’s manual is mandatory before using TomoCon 
clinically. 

Diagnosing users should be aware that certain views might display interpolated data. 
Interpolated data, although based on the original data set, may give the appearance of 
healthy tissue in situations, where pathology, which is smaller than the scanning 
resolution, may be present. Occasionally, interpolated data may also include image 
artifacts, which should not be interpreted as real pathology. 

TomoCon saves images together with patient personal information (when saving to 
the local database and when exporting from TomoCon). It is important to protect this 
data from access by unauthorized persons. 

1.3 Medical device class and CE Mark 
TomoCon 3.0 has been classified as a Class IIa medical device, according to the 
directive MDD 93/42/EEC and has been certified so. Written declaration of 
conformity is available on request (see 4 Contact). 

0434 
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2 Installing and uninstalling TomoCon 

2.1 System installation requirements 
TomoCon requires following hardware and software as minimal configuration 
(recommendations are in parenthesis): 

2.1.1  Hardware requirements 
• CPU Pentium, min. 1 GHz clock speed (Pentium 4 2.5 GHz and 

higher), 

• Memory 256 MB (512 MB), 

• CD-ROM, 

• Hard Disk 100 MB free disk space for software installation (at least 
10 GB for patient image data), 

• Display 19” CRT or 17” LCD color monitor (21” CRT or 19” LCD 
monitor, two monitors with dual-head graphics adapter), 

• Graphic Card 1024x768 pixel resolution, True color (32 bit color depth), 
(dual-head graphics adapter, 3D-accelerated graphics). 

2.1.2  Additional hardware recommendation 
• Printer port or USB port for attaching hardware protection dongle, 

• Network port for data acquisition, connection to PACS systems, 

• Backup system based on magnetic tape, CD-R or HD media. 

2.1.3  Software requirements 
TomoCon Workstation: 

• Operating System Microsoft Windows 2000, XP Professional, 

• Microsoft Internet Explorer version 5.5 or higher, 

TomoCon Viewer, TomoCon Lite: 

• Operating System Microsoft Windows 98 SE (some functions of 
application are not available), 2000, XP Professional, 

• Microsoft Internet Explorer version 5.5 or higher. 
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2.2 Installing TomoCon 

1. Insert the installation CD into the drive. A window should be displayed 
automatically after a while, allowing you to select TomoCon to install. If it 
displays, proceed to step 3. If it does not display, follow step 2. 

2. Run SETUP.EXE from the installation CD. You can do this by double-
clicking on 'My Computer' icon on your desktop, then double-clicking the 
icon of your CD-ROM drive ('D' for example), and finally double-clicking 
'Setup' or 'Setup.exe' executable file. 

3. Follow the instructions given by the Setup program of TomoCon. 

2.3 Uninstalling TomoCon 
To uninstall TomoCon, click the MS Windows Start button, go through Settings, 
Control Panel and start Add/Remove Programs. From the list of currently installed 
programs select TomoCon and press the Change/Remove button. 
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3 TomoCon description 

To start TomoCon, click the MS Windows Start button; go through Programs, 
TomoCon 3.0 and finally TomoCon. 

Optional start-up parameters: 

• /t – to start TomoCon in touch screen mode, (see 3.21Touch screen mode). 

3.1 TomoCon basics 
TomoCon is intended to be used for patient image data visualisation and handling. To 
view a patient, the following actions are generally required: 

• Open patient studies (see 3.3 Open a patient study), 

• View images, 

• Check and define new grayscale window and level (see 3.4 Window and 
Level manipulations), 

• Define volumes of interest (see 3.11 Contouring the patient – create ROIs), 

• Describe selected images (see 3.9 Annotations and measurements), 

• Print reviewed patient image data (see 3.19 Print images on a MS Windows 
printer), 

• Print chosen patient image data on DICOM printer (see 3.20 Print images on 
a DICOM printer), 

• Save modified patient data to disk (see 3.25 Save a patient study), 

• Back up patient image data (see 3.27 Archive patient studies on CD). 

3.1.1  Series and Images 
Patient images are often grouped in series of images. These series create one patient 
study. The complete patient data consists of one or more patient studies. 

3.1.2  Coordinate Systems 
To be able to display the image position in the patient coordinate space a 
transformation between images and the real patient have to be defined. 

Once the transformation has been defined, it is possible to calculate the corresponding 
[x, y, z] position in the patient’s body. 

Orientations used in TomoCon:  

• Anterior,  
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• Posterior,  

• Left,  

• Right,  

• Head, 

• Feet. 

TomoCon’s coordinate system: 

• +x axis points to the R (patient’s right side, direction left-to-right), 

• +y axis points to the A (patient’s front side, direction back-to-front), 

• +z axis points to the H (top of the patient, direction feet-to-head). 

The coordinates are displayed in millimetres, angles in degrees.  

3.1.2.1 Image Transformation 
If Image Transformation is available in imported patient images from an imaging 
device, it is kept and stored with patient data.  

After clicking into an image with available transformation, a corresponding spatial 
position can be calculated. 

3.1.2.2 No Transformation 
If the patient data does not contain sufficient information about the placement of 
images in the coordinate space, the images are handled as simple images. It is not 
possible to obtain positional coordinates by clicking at the image pixels. 

Contours drawn in these images are not displayed in MPR, 3D views and it is not 
possible to use them to define ROI. 

3.1.3  Current point 
After clicking into an image, a corresponding position is calculated and displayed as 
the current point in the Status bar (see 3.1.4.5 Status bar). If the series is displayed in 
the Status bar, it informs which series the displayed position belongs to. 

The image pixel size affects precision of all measurements (the bigger pixel size, the 
lower measurement precision). 

In 2D measurements, the precision is a function of the pixel size: 

 sm PDD ⋅±= 2  

Where D is distance, Dm is measured distance and Ps is pixel size, 
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 smm PSSS ⋅⋅±= 4  

Where S is area, Sm is measured area and Ps is pixel size.  

3.1.4  Main application window 
The TomoCon main application window (see Figure 1) consists of the following 
parts: 

• Working area (see 3.1.4.1 Working area), 

• Thumbnail palette (see 3.1.4.2 Thumbnail palette), 

• Main menu (see 3.1.4.3 Main menu), 

• Toolbars (see 3.1.4.4 Toolbars), 

• Status bar (see 3.1.4.5 Status bar). 

 
Figure 1 TomoCon application window 

3.1.4.1 Working area  
This is a large black area and may be divided into smaller windows – called views in 
this document. When the application is starting, one working area is created (see 
Figure 1), which is bound to the application window and it is not possible to move it. 
It is possible to display additional working areas (see Figure 2), which can be freely 
resized and placed anywhere on different screens. 

Working area consists of windows, which are called views. Each view can display 
different type of view on patient data (view of slice selected from thumbnail view, 
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MPR view, 3D view, etc.). After selecting a view with a primary mouse button, this 
will become a current view outlined with a coloured frame (you can change the colour 
of the frame, see 3.2.5 Color settings). The current view is used for all image 
manipulations. Make another view the current view anytime simply by selecting it 
with the single click of the mouse. 

 
Figure 2 Working area 

Use the slider on the right side of the working area to move the images of the chosen 
series (or the multi-frame images) in the current view. The slider position represents 
approximate image position in the series. 

When a multi-frame image is displayed in the current view, the slider bar is divided in 
two parts separated with a square box (see Figure 3). Use the slider in the upper part 
to move between the multi-frame images of the chosen series in the current view. The 
slider in the bottom part is used to move between the frames of the multi-frame image 
in the current view. In the box between the sliders the current frame number of the 
multi-frame image is displayed. 

 
Figure 3 Working area with multi-frame image in the current view 
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3.1.4.2 Thumbnail palette 
The thumbnail palette (see Figure 4) is placed on the right side of the main application 
window by default and contains images of opened studies displayed as thumbnail 
previews.  

  

  
 

Study name with displayed 
previews 

Chosen study name 
(hidden previews) 

Thumbnail palette slider 

MR1 series thumbnail 
previews 

Chosen series MR1

PT1 series with hidden 
thumbnails 

Image in the current 
view 

  
Figure 4 Thumbnail palette (Tabbed mode) 

Each study is displayed in the Thumbnail palette as a tab with patient name and an 
examination date (date of creating the study), if the date is available. Under these tabs 
there are reduced images of the series displayed according to the selected series 
representation type for the study in the Thumbnail palette. Selection of this 
representation type is possible using the Thumbnail palette’s context menu (after 
pressing right mouse button on the selected study in the thumbnail palette and 
selecting the Show series item). Thumbnail palette supports 3 different series 
representation types for the study: 

• Tabbed mode, selection of the series, which thumbnails are to be displayed, 
can be selected by clicking with the primary mouse button at the button with 
the series name in the list of series. Only one series from the study can be 
displayed at a time (see Figure 5 a), 

• All – separated, thumbnails of all series of the study are displayed at once, 
sorted according to series (see Figure 5 b), 

• All – in one, reduced thumbnails of all series of the study are displayed at 
once one after another without dividing them into series (see Figure 6). 
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    (a)                  (b) 

Figure 5 Dispalying series in Tabbed mode (a), All – separated (b) 

 
Figure 6 Displaying series in All – in one mode 

Similar to the selection of the series representation type in the Thumbnail palette, it is 
also possible to select the image representation type in the series. Image 
representation type is possible using the Thumbnail palette’s context menu and 
selecting the Show images item (see Figure 7). Thumbnail palette supports following 
image representation types for the series: 

• Show all images, all images of each series of the selected study are displayed, 

• 1 image out of, selected number speciefies the image interval of each series of 
the selected study to display, 

• One image only, first image of each series of the selected study is displayed, 

• First, middle and last, first, middle and last image of each series of the 
selected study is displayed. 

 
Figure 7 Context menu for selection of the image representation type 

Additionally, image thumbnails from the selected study can be sorted in the 
Thumbnail palette using the Sort images by context menu item (see Figure 8): 

o Index number – as opened in TomoCon, 
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o Instance number – instance number value in DICOM data, 

o Slice position – image sorted by slice position, 

o Reverse sort mode. 

 
Figure 8 Context menu for sorting images 

Tabs with opened patient studies can be folded / unfolded by moving the mouse 
cursor over the patient’s name and clicking the primary mouse button at the chosen 
study. When the triangle arrow in front of the patient name directs to the patient’s 
name, the thumbnails are folded; when the triangle arrow points down, the thumbnails 
are unfolded and can be seen. 

NOTE! When there is only one patient study opened in TomoCon, the thumbnails are 
always visible and it is not possible to fold them. 

When opening a new patient study in TomoCon all studies already in TomoCon will 
be automatically folded and the first series of the new patient will be displayed. Use 
the slider on the right side of the thumbnail palette to choose from the series 
(thumbnails) that could not be seen on the screen. 

After clicking on a thumbnail preview in the thumbnail palette, the corresponding 
image will be copied into the current view and the thumbnail preview in the palette 
will be highlighted in the same color as the current view. 

The thumbnail palette may be resized and can be docked inside the application border, 
can be also floating, placed anywhere on the screen. When starting the application the 
thumbnail palette is docked at the right side border. Afterwards its size and position 
can be changed. The position can be changed by dragging and moving the palette the 
same way as moving the toolbars. 

It is possible to display multiple thumbnail palettes, e.g. each one with different series 
displayed (see 3.1.5.8 View menu).       

3.1.4.3 Main menu 
The TomoCon main menu (see Figure 9) consists of the following menus: 

• TomoCon – application settings, image data print (see 3.1.5.1 TomoCon 
menu), 

• Study – patient study handling (see 3.1.5.2 Study menu), 

• Tools – tools for image data handling (see 3.1.5.3 Tools menu), 
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• Image – view images and manipulation with images (see 3.1.5.4 Image 
menu), 

• Filter – filters to soften or sharpen the current view (see 3.1.5.5 Filter menu), 

• Annotations – create annotations in the current view (see 3.1.5.6 Annotations 
menu), 

• Flip/Rotate – flip and rotate image in the current view (see 3.1.5.7 
Flip/Rotate menu), 

• View – display / hide parts of the main menu, image descriptions, change the 
current view size, delete views, create image sequence, etc. (see 3.1.5.8 View 
menu),  

• Help (see 3.1.5.9 Help menu). 

 
Figure 9 Main menu 

3.1.4.4 Toolbars 
Following toolbars are available in TomoCon. They contain frequently used tools 
from the main menu: 

• Context bar (see Figure 10), 

• Standard toolbar: 

o Large toolbar (see Figure 11), 

o Small toolbar (see Figure 12), 

• Annotations (see Figure 13), 

• Flip/Rotate (see Figure 14). 

All toolbars can be resized and docked anywhere inside the application border, 
can be also floating and placed anywhere on the screen. 

  
Figure 10 Context bar 
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Figure 11 Standard bar (big version) 

 
Figure 12 Standard bar (small version) 

 
Figure 13 Annotations bar 

 
Figure 14 Flip and rotate 

3.1.4.5 Status bar 
The Status bar is located at the bottom part of the application. If the user selects a 
menu item or a toolbar button, its description appears on the left side of the Status bar 
(instead of the text: “TomoCon 3.0 Ready”). 

Following information will be displayed on the right side of the Status bar and can be 
set up in the TomoCon menu, Setup, the TomoCon setup dialog, the View/Controls 
tab (see 3.1.5.1 TomoCon menu): 

• Series – current point series, 

• Value – gray level in current point, 

• Current – current point coordinates. 

 
Current point series 

Current point position [x,y,z] 

Gray level 

 
Figure 15 Status bar 

3.1.5  Navigating through the menus 

3.1.5.1 TomoCon menu 
The TomoCon menu consists of the following items (see Figure 16): 
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• Setup… - set up the application (see 3.2 Setting up the application – User 
Preferences), 

• Print… - print patient data on a MS Windows printer (see 3.19 Print images 
on a MS Windows printer), 

• DICOM Print… - print patient data on a DICOM printer (see 3.20 Print 
images on a DICOM printer), 

• Exit - close the application.  

 
Figure 16 TomoCon menu 

3.1.5.2 Study menu 
Following options are available in the Study menu (see Figure 17): 

• Open study… - open selected DICOM studies retrieved from the external data 
source or open them from the Local Studies (see 3.3 Open a patient study), 

• Save - save modified DICOM studies to Local studies (see 3.25 Save a 
patient study), 

• Close – close all open DICOM studies (see 3.26 Close a patient study), 

• Anonymize study… - anonymize opened studies (see 3.23 Study 
anonymization ), 

• Export images… - export selected patient image (or series of images) into 
bitmap file (see 3.24.1 Export images), 

• Export as AVI video… - create a video file from a multi-frame image or the 
series of patient images (see 3.24.2 Export images to AVI format video file), 

• Create CD… - archive DICOM study and burn a CD (see 3.27 Archive 
patient studies on CD), 

• Reports… – view and edit structured reports (see 3.22 Structured reports), 

• Study info… - display information about the current study. 
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Figure 17 Study menu 

3.1.5.3 Tools menu 
TomoCon contains Tools (see Figure 18) for patient image handling: 

• ROIs… - create and modify ROI (see 3.11. Contouring the patient – create 
ROIs), 

• MPR… - display MPRs through the patient image data (see 3.12. MPR – 
Multi Planar Reformatting), 

• Image fusion… - display image fusion of registered series (see 3.16 Image 
fusion), 

• 3D view… - display three-dimensional patient image data representation (see 
3.14. Three-Dimensional Visualization), 

• DRR… – create Digitally Reconstructed Radiograph of the patient image data 
(see 3.13 DRR Reprojection), 

• Window/Level… - Window and level manipulations (see 3.4. Window and 
Level manipulations), 

• Zoom… - zooming the current view in or out (see 3.5. Zooming image 
views), 

• Cine… - play back multi-frame images or series in multi-frame (Cine) mode 
(like a movie), (see 3.10. Play multi-frame images – Cine dialog), 

• DSA… - display XA images with highlighted difference between scans 
without and with contrast media (see 3.17. DSA – Digital Subtraction 
Angiography), 

• Registrations… – make registration between series of patient image data (see 
3.15. Registrations), 

• Touch screen mode – run the touch screen mode (see 3.21 Touch screen 
mode). 



TomoCon 3.0 User’s Manual 

 

21 

 
Figure 18 Tools menu 

3.1.5.4 Image menu 
The Image menu (see Figure 19) allows simple image manipulations and browsing: 

• Point selection - a click inside the image selects the current point and obtains 
coordinates and grayscale level (e.g. Hounsfield in CT) values of this current 
point. This information can be shown in the Status bar (see 3.2.1 Setting up 
the application), 

• ROI selection - highlight ROI in the image whenever mouse pointer hovers 
over it,  

• Turn on/off simple image data modifications in the current view: 

o Change Window and level settings – Window/Level, Window/Level 
rectangle (see 3.4 Window and Level manipulations), 

o Invert current image (reverse black and white colours) 

o Zoom in or out, Zoom rectangle (see 3.5 Zooming image views), 

o Move the image, 

• MPR rotate, MPR move - rotate and move MPRs, 

• Previous and Next - scrolling through the series of images or MPRs, 

• DICOM dump… - display detailed DICOM information about image in the 
current view. 
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Figure 19 Image menu 

3.1.5.5 Filter menu 
The Filter menu (see Figure 20) automatically applies Image processing filters to the 
image: 

• Soften image, 

• Sharpen image, 

• Equalize levels using histogram (Histogram equalization), 

• Turn off the filter (Original image). 

 
Figure 20 Filter menu 

3.1.5.6 Annotations menu 
The Annotations menu (see Figure 21) allows following operations in the image: 

• Using annotations and measurements: 

o Freely positioned Text in the image, 

o Description Markers for specific image points, 

o Distance between two points, 

o Distances and angle between three points, 

o Probe – current point value, 

o Density profile over the line between two points, 
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o Density profile over the elliptical (Ellipse), rectangular (Rectangle) or 
freely outlined area (Area), 

• Delete / Delete all annotations, 

• Display the list of annotations (Annotations…). 

For detailed description see 3.9 Annotations and measurements. 

 
Figure 21 Annotations menu 

3.1.5.7 Flip/Rotate menu 
The Flip/Rotate menu (see Figure 22) allows following actions with the current view: 

• Rotate right, 

• Rotate left, 

• Flip horizontal, 

• Flip vertical, 

• Original orientation. 

 
Figure 22 Flip/Rotate menu 

3.1.5.8 View menu 
Following functions are available through the View menu (see Figure 23): 

• Toolbars – hide or display toolbars: 

o Large toolbar (see Figure 11), 

o Small toolbar (see Figure 12), 

o Context bar (see Figure 10), 
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o Annotations (see Figure 13),  

o Flip/Rotate (see Figure 14), 

o Status bar (see Figure 15), 

• Create new working area, 

• Main thumbnail palette – display/hide main thumbnail palette, 

• Create new thumbnail palette – create additional thumbnail palette, 

• Point selection cursor – display/hide red cross on the current point’s position, 

• Text - display/hide text description in the view, 

• Ruler – display/hide horizontal and vertical ruler, 

• Curves – display/hide curves in the image views, e.g. ECG, 

• Shutter – display/hide image views using predefined shutter mask settings, 

• Annotations – display/hide annotations and measurements, 

• Overlay – display/hide overlays if they are available, 

• Cutlines (see 3.18 Cutlines), 

• View size – change the current view size (see 3.6 Current view size), 

• Create slice sequence (see 3.7 Creating a sequence of slices),  

• Series synchronization – create series synchronization (see 3.8 
Synchronizing displayed series), 

• Copy to clipboard – copy image in the current view to the clipboard, 

• Reset view – reset zoom, window & level, position and rotation settings of the 
current view to default levels, 

• Clear view – clear the current view, 

• Clear all views – clear all views of the current working area. 
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Figure 23 View menu 

3.1.5.9 Help menu 
Use the Help menu to obtain the application version or browse the on-line user’s 
manual (see Figure 24): 

 
Figure 24 Help menu 

• TomoCon manual – on-line manual will be opened, 

• About… – the About… dialog is opened informing about the current 
application version. 
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3.2 Setting up the application – User Preferences 
The TomoCon setup dialog can be opened by clicking at the Setup… submenu in the 
TomoCon menu (see 3.1.5.1 TomoCon menu). The TomoCon setup dialog (see 
Figure 25) allows to: 

• Set up the mouse wheel and buttons behaviour and the application settings 
(see 3.2.1 Setting up the application), 

• Display/hide text types in views (see 3.2.3 Displayed texts in views ), 

• Set up the modality settings (see 3.2.4 Modality settings), 

• Set up color shades and shape of TomoCon’s objects (see 3.2.5 Color 
settings), 

• Set up the application language (see 3.2.6 Application language). 

Application settings except the language settings changed with the TomoCon setup 
dialog are saved and immediately applicable to the opened application. 

3.2.1  Setting up the application 
Common application settings can be set up in the View/Controls tab (see Figure 25), 
the TomoCon setup dialog (see 3.1.5.1 TomoCon menu):  

• View options – view settings: 

o Turn on/off non-square views (Allow non-square views), 

o Turn on/off DSA mode automatic activation (Always apply DSA) – if the 
image in the current view contains DICOM structure for DSA, 

• Status bar options – information displayed at the bottom of the Status bar: 

o Turn on/off displaying current point series identifications (Series), 

o Turn on/off displaying current point level values (Level), 

o Turn on/off displaying current point coordinates (Current point),  

• Open on patient load – display selected dialogs after selecting and opening 
patient:  

o The Gray dialog (see 3.4 Window and Level manipulations), 

o The Zoom dialog (see 3.5 Zooming image views), 

o The Cine dialog (see 3.10 Play multi-frame images – Cine dialog), 

• Mouse options: 
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o For more Mouse options using the buttons and the scrolling wheel in the 
current view (see 3.2.2  Mouse actions). 

 
Figure 25 TomoCon setup dialog, View/Controls tab 

3.2.2  Mouse actions 
Actions associated with mouse buttons and the scrolling wheel can be activated in the 
View/Controls tab, the TomoCon setup dialog (see Figure 25): 

Choose following actions to be associated with mouse buttons and the scrolling 
wheel: 

• --No action – the mouse button will not be used in TomoCon, 

• Context menu - after pressing the mouse button the current view’s context 
menu will appear, 

• Primary action - the mouse button will act according to the function specified 
in toolbars and dialogs; NOTE! Only Primary action button can be used to 
define the current point, obtain coordinates and gray level values, 

• Move action, Zoom action, Gray action, GrayRect action - the mouse 
button will do only the selected function. 

Additionally, scrolling the mouse wheel (often functional as the middle mouse button) 
can be used in different ways: 

• Scroll by images – move the images within the series in the current view 
backwards and forwards, 

• Scroll by frames – move the images of the multi-frame image in the current 
view backwards and forwards; the function is not available for single images,  

• Combine scrolling – move the single and multi-frame images in the current 
view within the series backwards and forwards. 
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It is possible to associate following actions with one and double mouse click on the 
view: 

• First click only activates a view, after clicking into an inactive view it will 
only become an active view. If this checkbox is not selected, after clicking 
into an inactive view it becomes an active view and selected action will be 
triggered in it immediately. 

• Double click starts/stops playback, double mouse click on selected view, 
which displays an image, will start or stop playback of multi-frame image in 
the active view (see 3.10 Play multi-frame images – Cine dialog). 

3.2.3  Displayed texts in views  
Each user may have their own specific requests for information displayed in various 
views. TomoCon comes with pre-configured set of texts, which will be displayed in 
each type of view and are freely adjustable by user (see Figure 26). Use the View 
texts tab in the TomoCon setup dialog to set up your own preferences. 

 
Figure 26 TomoCon setup dialog, View texts tab 

Select a view type to be adjusted. Four identical square areas represent four view 
corners and contain description texts to be displayed in the corresponding corner. The 
fifth rectangular area on the left side contains unused description texts. The 
descriptions can be moved with mouse per drag-and-drop between the five areas. 

Press the Apply button to use the selected settings.  

The Default button returns to the factory defaults.  

The Font button allows selection of different fonts or font sizes for the description 
texts. New font settings will be applied immediately. 



TomoCon 3.0 User’s Manual 

 

29 

3.2.4  Modality settings 
Use the Modality settings tab in the TomoCon setup dialog (see Figure 27) to set up 
properties separated for each modality: 

     
          (a)        (b) 

Figure 27 TomoCon setup dialog, Modality settings tab,  
Window/Level presets sub tab (a), Window/level preset dialog (b) 

It is possible to set up the following properties for each modality: 

• Window/Level presets sub tab (see Figure 27 a) collects user-defined 
window, level and shape combinations for each modality, which are used in 
image grayscale settings. These combinations may be bound to keyboard 
function keys F2 to F9 as accelerators.  

 New presets can be added after pressing the Add button and already existing 
 ones can be modified by pressing Edit in the Window/Level preset dialog. 

 A combination chosen from the list can be deleted after pressing the Delete 
 button or edited by pressing the Edit button. When pressing the Edit 
 button the Window/Level preset dialog (see Figure 27), which allows you to
 make the changes, will be opened. 

• Advanced sub tab (see Figure 28) allows to: 

o Select Color map palettes,  

o Palette gradation type (Window type and Default shape), 

o Define default Cine frame rate (Default frame rate, Use image frame rate), 

o Image interpolation mode - specify bitmap interpolation mode for image 
data visualisation: 

 None, 

 Bilinear, 
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 Bicubic, 

o Turn on/off the Enable supersampling function. 

 
Figure 28 TomoCon setup dialog, Modality settings tab, Advanced sub tab 

• Layout (see Figure 29) – depending on the modality allows following actions 
after opening the first study: 

o Load layout – fill the views with the first images of the first series opened 
in TomoCon.  

o NOTE! If the Create slice sequence option is activated, the views will be 
filled only if the first series of the first study opened in TomoCon  does not 
contain multi-frame images; 

o Create slice sequence from all views in the working area. 

o Set the view layout (number of rows and columns) 

 Rows, 

 Columns. 

 
Figure 29 TomoCon setup dialog, Modality settings tab, Layout sub tab 



TomoCon 3.0 User’s Manual 

 

31 

3.2.5  Color settings 
Default colors of certain displayed objects in TomoCon can be changed in the Colors 
tab, the TomoCon setup dialog (see Figure 30). It is possible to change colors for: 

• Cutline: 

o Standard, 

o Current, 

• Point selection cursor, 

• Overlay, 

• Curves, e.g. ECG, 

• Window frame  

o Standard – frame views in the working area and in the thumbnail palette, 

o Selected – frame the chosen current view in the working area and in the 
thumbnail palette, 

o Slice sequence – frame slice sequence views, 

• MPR intersection – current view’s MPR position in other views and in the 
thumbnail palette, 

• Text – text information in the views. 

 
Figure 30 TomoCon setup dialog, Colors tab 

Click at the Color button or the current object’s color box in Settings to choose a 
color. A dialog will be opened with default color palette or a palette created by the 
user. Click at the selected color; press Default to return to the default color.  

Change the line types: 

• Solid, 

• Dashed, 
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• Dotted, 

• Dash-dot. 

Change the text type: 

• Simple, 

• Extended. 

In Preview the subject with changed color or shape will be displayed. 

3.2.6  Application language 
TomoCon allows to select the application language using the Language tab in the 
TomoCon dialog (see Figure 31): 

• Slovak, 

• Czech, 

• English. 

The language will be changed after restarting the application. 

 
Figure 31 TomoCon setup dialog, Language tab 
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3.3 Open a patient study 
The Search studies dialog (see Figure 32) allows to search and open selected study of 
patient in TomoCon. 

A dialog will be opened by either clicking at the  Open study icon the Standard 
toolbar or the Open study… submenu in the Study menu (see 3.1.5.2 Study menu). 

TomoCon enables handling patient image data, archived on following data storages: 

• Local studies (see 3.3.2 Local studies), 

• DICOM format source (CD, HD, etc.) (see 3.3.5 DICOMDIR), 

• PACS system (see 3.3.4 TomoCon PACS server), 

• Device with DICOM protocol (see 3.3.6 External data acquisition devices). 

TomoCon application saves all data in the local studies on the local workstation. It is 
also possible to export the data from this storage to other external data storage 

3.3.1  Studies filter 
When opening a study from any type of data source (except DICOMDIR), only 
studies meeting selected requirements will be displayed. Select requirements at the 
top of the Search studies dialog, the Filter part (see Figure 32): 

Following criteria are available: 

• Patient name, 

• Accession number, 

• Patient ID, 

• Examination date: 

o Today, 

o Yesterday, 

o From – To, 

• Date of birth, 

• Sex, 

• Modality: 

o All Modalities, 

o Choose a modality. 

After pressing the Search button the search process will be started and a list of studies 
will be displayed in the Search studies dialog window. These studies can be then 
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sorted according to the selected study parameter (by clicking at the column header, 
where is the selected parameter displayed). 

For each study it is possible to unfold a list of series by clicking at the  symbol or 
fold the list by clicking at the  symbol. Unfolded series list displays basic series 
information including number of images in the series. 

Studies can be selected by marking the particular study in the list (by clicking at the 
study) or marking multiple studies while holding the Ctrl key (selection of more 
single studies) or the Shift key (selection of a group of studies between two clicked 
studies). 

3.3.2  Local studies 
DICOM data is retrieved from external data sources and stored locally in the Local 
studies area. All studies stored in this area can be searched in the Local studies tab 
(see Figure 32) and after select they can be opened. 

 
Figure 32 Search studies dialog 

After pressing the Search button the searching process will start and studies fulfilling 
the specified criteria will be displayed. 

Selected studies can be opened in TomoCon (after pressing the Open study button). 

Dialog also supports following operations with each selected study in this list: 

• lock study against automatic deletion (after pressing the Lock/Unlock button),  

• send study to external PACS server (after pressing the Send button), 

• delete study (after pressing the Delete button), 

• burn study on CD (after pressing the Create CD button the Create CD dialog 
will be opened (see 3.27 Archive patient studies on CD), after pressing the 
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Add button the selected study will be added to the list of studies, ready to be 
burned). 

3.3.3  Opening multiple studies 
Multiple patient studies can be opened simultaneously in TomoCon. When opening 
another study, a dialog will be opened (see Figure 33). Choose the No button if you 
want to keep the currently opened studies. Press Yes to close the studies. 

 
Figure 33 “Close currently opened studies?” message box 

3.3.4  TomoCon PACS server 
TomoCon can be connected to any standard PACS server for data acquisition. The 
default one is TomoCon PACS server, pre-configured for the immediate use. 
Detailed information is accessible through the PACS studies tab, the Search studies 
dialog (see Figure 34).  

 
Figure 34 Search studies on PACS server dialog 

The selected study can be retrieved from PACS server into Local studies area by 
pressing the Retrieve button. After pressing the Open study button instead of 
Retrieve, the study will be automatically opened in TomoCon immediately after 
being retrieved from the PACS server. 
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3.3.5  DICOMDIR 
Any data stored in DICOM format, whether on CD, HD or shared network server 
directory, can be accessed over the DICOMDIR selection (see Figure 35). 

 
Figure 35 Search studies in DICOMDIR dialog 

After pressing the Search button, TomoCon will ask for the directory pointing to the 
DICOM data. 

In the DICOMDIR area it is not possible to specify settings in the Filter box for data 
selection. 

3.3.6  External data acquisition devices  
Multiple available data acquisition devices and PACS servers can be defined and 
accessed over network. They can be specified after pressing the Options… button. 
After the specification (see 3.3.8 Settings), the new DICOM data source will be 
displayed as another data source (a new tab with the source name) in the Search 
studies dialog. 

3.3.7  Send study to external data device 
Patient data can be sent over network to any PACS server or other DICOM data 
storage device. In the Local studies area, the Search studies dialog, select a study 
and press the Send button. If multiple remote devices are available and defined, the 
Select remote device dialog (see Figure 36) will pop up to specify the target device. 
Select the desired remote device and press the OK button. The study will be sent. To 
define DICOM data source see the Options dialog (see 3.3.8 Settings). 
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Figure 36 Select remote device dialog 

3.3.8  Settings 
Following settings are available through the Options dialog (see Figure 37 a) that will 
be displayed after pressing Options in the Search studies dialog: 

• Local studies folder – local studies folder properties (see 3.3.8.1 Local 
studies properties), 

• Local DICOM settings – settings for importing DICOM data to TomoCon 
(see 3.3.8.2 DICOM receiver settings), 

• Remote devices – external devices settings for DICOM data exchange (see 
3.3.8.3 External DICOM device configuration). 

  
         (a)                                               (b) 

Figure 37 Options dialog (a), Device configuration dialog (b) 

3.3.8.1 Local studies properties 
It is possible to define a folder for Local Studies in the Options dialog (see Figure 37 
a). If saved data size exceeds Maximal used capacity, the oldest studies if not locked 
against deleting will be deleted. 
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3.3.8.2 DICOM receiver settings 
TomoCon has its own local DICOM receiver that saves patient data automatically to 
Local studies. It is possible to set following properties: 

• AE Title, 

• Listen port – port for receiving DICOM data. 

3.3.8.3 External DICOM device configuration 
DICOM device definition can be added (Add) and configured (Configure…). After 
pressing one of these buttons a device configuration dialog will be opened (see Figure 
37 b). The new device, named in Description, will be displayed in Remote devices 
and in the Search studies dialog. It is possible to reach it the same way as the other 
data sources. 
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3.4 Window and Level manipulations 
To be able to see patient image data with correct contrast and image details in some 
particular grayscale range, the user can change the gray level and window with the 
Window/Level dialog (see Figure 38). It will be opened by either clicking at the  
Window and Level… icon in the Standard toolbar or Window/Level… submenu in 
the Tools menu (see 3.1.5.3 Tools menu). 

  
Figure 38 Window/Level dialog variants 

Changes made with the Window and Level sliders will be only seen in the current 
view and stay valid until a new image from the thumbnail palette is chosen. The 
window and level values will be then set up according to the chosen image.  

After pressing the Apply button the changes are applied and stored to the image in the 
current view (it can be seen in the thumbnail palette). After pressing the Apply to all 
button, the same changes are applied and stored to all images from the current series, 
including all 3D, MPR, fusion and other view types.  

Pressing the Reset button will restore original window and level settings (these 
settings are from the imaging device and are never discarded from the patient data) in 
all views of the current series (series that the current view belongs to). 

The palette gradation Shape modifies the black-gray-white gradation curve of the 
selected palette. It can be used after a non-linear color map palette Window type has 
been selected (see 3.2.4 Modality settings). 

Users can create and use their own “predefined window, level and shape settings” by 
clicking at a small triangle at the right side of the black-gray-white bar  in 
the Window/Level dialog and selecting the New preset… menu. The Window/Level 
preset dialog will be opened (see Figure 39). Old presets can be changed and a new 
own preset for the selected modality can be described with its own name (Preset 
name) and stored for later use. Choose any keyboard shortcut F2 to F9 from the Key 
combo box to be bound with the selected presets. The new presets will be activated by 
pressing the keyboard shortcut or by clicking at the preset in the list of presets. 

Use the same process to set up window, level and shape for each modality in 
Modality settings tab, the TomoCon setup dialog (see 3.2.4 Modality settings). 
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Figure 39 Window/Level dialog – defining new Window/Level/Shape preset 

To modify window and level simultaneously without opening the Window/Level 
dialog, click at the  Window/Level icon in the Image menu or at the Context 
toolbar (mouse cursor will get  form). Then click at the view and move the mouse 
(with the primary mouse button pressed) horizontally (window) and vertically (level). 
Level and window are changed immediately.  

For optimal level and window setting for the patient images you can also use the 
Window/Level Rectangle function in the Image menu or in the context menu. Click 
at the  Window/Level Rectangle icon. The mouse cursor will get form. Click 
into the image and hold the mouse button. Move the cursor (shaped ) across the 
area. A rectangle will be drawn around the area. You can cancel the dragged rectangle 
by pressing the Esc button on the keyboard. After releasing the mouse button, window 
and level will be set for optimal contrast in the area within the rectangle. 

The Window/Level and Window/Level rectangle functions apply only to the current 
view. The window and level changes from current view can be also applied to the 
image (which will be also displayed in the thumbnail preview). Press Apply in the 
current view’s context menu to apply this changes to the image. Press Apply to all to 
apply this changes to all images and views of the current series. 
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3.5 Zooming image views 
The Zoom dialog (see Figure 40) can be used for zooming details in the image, e.g. 
while contouring small structures or clicking reference points. It can be opened by 
either clicking at the  Zoom icon in the Standard toolbar or the Zoom… submenu 
in the Tools menu. 

 
Figure 40 Zoom dialog 

The Zoom factor can be varied between 50% and 1600%. It applies immediately to 
the current view. The same effect has scrolling the mouse wheel while the Ctrl button 
is pressed on the keyboard. The image is zoomed from the middle of the view equally 
to all directions. You might need to move the zoomed part of the image to the side 
with the Move function in the Image menu or by pressing the  Move icon in the 
Context bar to see desired detail. 

Click on the Apply button in the Zoom dialog to apply the zoom to the image opened 
in more views and to the thumbnail preview. Click on the Apply to all button in the 
Zoom dialog to apply the zoom to all images, views and thumbnail previews of the 
same series. 

To modify the zoom factor using the mouse (without opening the Zoom dialog), click 
at the  Zoom icon in the Image menu or on the Context toolbar (mouse cursor will 
get form). Click in the view and move the mouse (with the primary mouse button 
pressed) in the image vertically. The image will be immediately zoomed and the 
clicked point will stay at the same position. This is useful when zooming a particular 
detail. 

Use the  Zoom rectangle function in the Context toolbar or in the Image menu to 
zoom an exact image area to the whole view size (up to the maximum of 1600%). 
Click at the icon (mouse cursor will get form), then click into the image and hold 
the mouse button. Move the cursor with mouse across the area, a rectangle will be 
drawn around the area. You can cancel the dragged rectangle by pressing the Esc 
button on the keyboard. After releasing the mouse button, the area within the 
rectangle will be zoomed to fill the view. 

The Zoom and Zoom rectangle functions apply only to the current view. The zoom 
changes from current view can be also applied to the image (which will be also 
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displayed in the thumbnail preview). Press Apply in the current view’s context menu 
to apply this changes to the image. Press Apply to all to apply this changes to all 
images and views of the current series. 

3.6 Current view size 
The current view size can be changed using the options in the View menu, View size 
(see Figure 41) or using the Standard toolbar. The following actions are available: 

•  Enlarge view - enlarge the current view up to the size of the main 
window, 

•  Reduce view - reduce the current view down to the original size, 

•  Restore all views - restore all views to their original sizes.  

 
Figure 41 View size options 
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3.7 Creating a sequence of slices 
Whole image series can be previewed in the thumbnail palette. However, thumbnail 
previews are rather small and lack additional text information. The solution is to 
create a Slice sequence by clicking at the Create slice sequence submenu in the 
View menu. 

 
Figure 42 Create slice sequence 

A small grid matching the currently selected views layout will be displayed. Mark any 
two views in the grid and the rectangular area of views between them will form a new 
sequence (see Figure 42) marked with a colored frame (see 3.2.5 Color settings). If 
you activate any of the sequence views and click at the thumbnail preview, the whole 
sequence of views will be filled with images around the selected one (see Figure 43). 
The selected image will be displayed in the current view. This set of images can be 
scrolled with Prev and Next icons located at the Standard toolbar or with the slider at 
the right side of the Working area.  

 
Figure 43 Slice sequence 

Multiple Slice sequences can be created containing same or different series. It is not 
possible to define overlapping areas of sequence views. 

Slice sequence can be deleted by clicking at the  Clear view icon in the View 
menu or at the Context toolbar when any sequence view is active. Clicking at the  
Clear all views in the View menu deletes all defined sequences. 
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3.8 Synchronizing displayed series 
Multiple series can be “locked” together to scroll synchronously in views. This mode 
can be selected by clicking at the Series synchronization submenu (see Figure 44) in 
the View menu. 

 
Figure 44 Series synchronization 

Two synchronization modes are available:  

• Automatic, 

• Manual. 

In automatic mode images from different series are displayed at matching or similar 
positions. While scrolling one view, images in other views are also scrolled at 
matching or similar positions. (It is not possible to use this mode when the patient is 
positioned differently while scanning the series.) 

In manual mode the displayed images in views are considered as “currently being 
displayed at correct positions”. While scrolling one view, images in other views are 
scrolled by approximately same offsets. 
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3.9 Annotations and measurements 
Annotations and measurements in TomoCon are used for measuring distances, angles, 
areas, density profiles and describing chosen parts of patient image data. TomoCon 
offers the following annotation and measurement tools: 

• Text – detailed information on text description (see 3.9.1 Text annotations), 

• Marker – text description with a marker pointing to the point described (see 
3.9.2 Marker annotations), 

• Distance – distance between two point (see 3.9.3 Distance), 

• Distances and angle (see 3.9.4 Distances and angle), 

• Probe – desired point level values (see 3.9.5 Probe), 

• Density profile - characteristics of all image points between two points (see 
3.9.6 Density profile), 

• Ellipse - characteristics of all image points covered by the elliptical area (see 
3.9.7 Ellipse), 

• Rectangle - characteristics of all image points covered by the rectangular area 
(see 3.9.8 Rectangle), 

• Area - characteristics of all image points covered by a free area (see 3.9.9 
Free area). 

All annotations and measurements can be found in the Annotations menu (see 3.1.5.6 
Annotations menu). It is also possible to activate them in the Annotations toolbar 
(see 3.1.4.4 Toolbars). After activating, the tools can be used only once. It means that 
every time you need to use a chosen tool, it is necessary to activate it again.  

After using an annotation and measurement tool, it is possible to set up its properties 
through the annotations and measurements context menu (see Figure 45). It will 
appear when moving the cursor over the tool (it will be highlighted and cursor will 
change from an arrow to a cross) and pressing the mouse context button. The 
following actions are available: 

• Font settings, 

• Color settings, 

• Keep settings – color and font settings for newly created annotations and 
measurements: 

o For all tools, 

o For same type tools, 
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• Edit label,  

• Delete a tool, 

• Locked a tool in the image against moving, deleting or above mentioned 
actions. 

 
Figure 45 Annotations and measurements context menu 

When using a tool covering an area (Ellipse, Rectangle, Free area), the Show text 
option is added (see Figure 46). The following actions are available: 

• Size of the outlined area, 

• Min value, 

• Max value, 

• Mean value, 

• Deviation. 

 
Figure 46 Context menu for ellipse, rectangle and free area 

When using Density profile, the Show/Hide graph option is added (see 3.9.6 Density 
profile). 

To move the annotation and the measuring tool to a different position within the view, 
move the mouse cursor over the annotation and the measuring tool until its 
highlighted (the cursor will change from an arrow to a cross). Hold the primary mouse 
button and release when desired. The annotation text will be moved together with the 
tool. 

When moving angle and distance measuring tool, it is also possible to move only one 
point at the end of the measuring line. When moving the mouse cursor over the 
chosen end point, this will change into a red circle (see Figure 48). Press the primary 
mouse button and move the point to a different place. 
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 After replacing the annotation and the measurement tool or its point the displayed 
values will be immediately recalculated. 

With every annotation you can use an edit box to write necessary notes about the 
annotations and measurements. When moving across the edit box with mouse cursor, 
it will be highlighted with rectangle in the same colour as the annotation connected 
with it. The mouse cursor will change its shape from an arrow to a cross. Hold the 
primary mouse button and relocate the edit box in position with the annotation. When 
moving the whole annotation the edit box will move with the annotation in the 
changed position. 

TomoCon calculates the real point distances or area automatically for patient images 
with transformation (see 3.1.2.1 Image Transformation). Images with no 
transformation (see 3.1.2.2 No Transformation) rarely contain sufficient information 
in the patient study data needed for these calculations. The calculations are therefore 
given in pixels. Conversion from pixels to length units (mm) or area units (cm2) can 
be done manually using calibration (see 3.9.10 Calibration). 

3.9.1  Text annotations 
Short text descriptions can be written directly inside the image, near the important 
structure or object using the Text annotation. Text annotation mode can be initiated 
by clicking at the  Text item in the Annotations menu. 

Click at the point in the image, which should be annotated. Small white text line 
editing box will be opened (see Figure 47). Type in the description text and press 
Enter.  

 
Figure 47 Image with Text annotations 

3.9.2  Marker annotations 
Short text descriptions pointing at the important structure or object can be written 
directly inside the image using the Marker annotation mode. It can be initiated by 
clicking at the  Marker item in the Annotations menu. 

Click at the point in the image, which should be annotated. Drag a thin line to the 
place, where the annotation text should be placed. Click the mouse button, a small 
white text line editing box will be opened. Type in the description text and press Enter 
(see Figure 48). 
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Figure 48 Image with Marker annotations 

3.9.3  Distance 
Distance measurement can be used after clicking at the  Distance item in the 
Annotations menu. 

Click at the first and at the second point, while dragging the measurement line. The 
distance between these two points is displayed near the second point (see Figure 49). 

   
Figure 49 Distance between 2 points 

3.9.4  Distances and angle 
Distances and angle measurement can be used after clicking at the  Distances and 
angle item in the Annotations menu. 

   

 
Figure 50 Distances and angle between 3 points 

It acts like Distance measurement, except that additional third point has to be defined. 
Both distances and an angle between distance-lines are displayed (see Figure 50). 

3.9.5  Probe 
Probe measurement can be used after clicking at the  Probe item in the 
Annotations menu. Click at the desired point. The value in the image point is 
displayed near the defined point (see Figure 51). 
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Figure 51 Probes at various points 

3.9.6  Density profile 
Line Density profile can be measured after clicking at the  Line density profile 
item in the Annotations menu. 

 
Figure 52 Density profile over a line between 2 points 

Click at the first point with the primary mouse button, hold it and drag a measurement 
line, until the mouse button is released. Characteristics of all image points covered by 
the line are summarized and displayed as a tool tip (see Figure 52). 

In open studies there can be more measurement lines created in the images. Their 
Density profiles can be temporarily hidden by clicking at the  button at the right top 
of the graph. After clicking at the measurement line with context mouse button, the 
Density profile will reappear by choosing the Show/Hide graph option (see Figure 
53). 

 
Figure 53 Density profile’s context menu  

3.9.7  Ellipse 
Ellipse drawing will be activated by clicking at the  Ellipse item in the 
Annotations menu. 

Click at any point with the primary mouse button, hold it and drag an ellipse between 
this point and mouse cursor. Characteristics of all image points covered by the 
elliptical area are summarized and displayed above the ellipse (see Figure 54). 
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Figure 54 Elliptical area profile 

You can move the ellipse to any place inside the image simply by grabbing it with 
mouse or resize it by grabbing its corners. The displayed values will be recalculated. 

3.9.8  Rectangle 
Rectangle drawing will be activated by clicking at the  Rectangle item in the 
Annotations menu. 

Click at any point with the primary mouse button, hold it and drag a rectangle 
between this point and mouse cursor. Characteristics of all image points, covered by 
the rectangular area, are summarized and displayed above the rectangle (see Figure 
55). 

 
Figure 55 Rectangular area profile 

You can move the rectangle to any place inside the image simply by grabbing it with 
mouse or resize it by grabbing its corners. The displayed values will be recalculated. 

3.9.9  Free area 
Free Area drawing will be activated by clicking at the  Area item in the 
Annotation menu. 

Outline an area dragging the  cursor with the primary mouse button pressed. 
Characteristics of all image points covered by the free area are summarized and 
displayed next to the free area (see Figure 56). 
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Figure 56 Free Area 

Press the  Area icon, hold the Ctrl keyboard and with the primary mouse button 
pressed add an extra area (the mouse cursor will have  form) to the already existing 
area. Press the icon again, hold Shift keyboard and with the primary mouse button 
pressed subtract a part of the area (the cursor will have  form).  

You can move the area to any place inside the image by grabbing it with mouse. The 
displayed values will be recalculated.  

3.9.10  Calibration 
In images with no transformation, where pixel size is unknown, calibration can be 
used to calculate approximate distance between two points. 

Choose Calibration (see Figure 57) in the Annotations context menu to activate 
calibration. The context menu will be displayed when pressing mouse context button 
at the distance type annotation.  

Two options are available: 

• Calibrate measurement – open the Calibration dialog to define the 
calibration (see Figure 57), 

• Apply to whole series – apply the defined calibration to the series. 

  
Figure 57 Calibration context menu and Calibration dialog 

The Calibration dialog allows to define the calibration by entering the chosen line 
length in millimetres in the Enter distance box. After pressing the OK button, all 
measured distances and areas in the image will be calculated according to the defined 
calibration.  
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The calibration of already calibrated images with no transformation can be changed 
again using the Calibration dialog. A dialog will be open informing that the image is 
already calibrated (see Figure 58). 

 
Figure 58 Calibration dialog; This slice is calibrated, proceed anyway? 

When changing the calibration in the series with calibrated images using the Apply to 
whole series option, a dialog will be open informing that the series is calibrated (see 
Figure 59). 

 
Figure 59 Calibration dialog; Any slice in series is calibrated, proceed anyway? 

NOTE! Calibration can not be used for images with transformation. 

3.9.11  Hide / show annotations 
To hide or show existing annotations in all views and TomoCon working areas, select 
the  Annotations icon in the View/Annotations menu or 
View/Toolbars/Annotations. 

3.9.12  Discard annotations 
A single annotation can be deleted by clicking at it with the context mouse button and 
selecting the Delete entry in the opened Annotations context menu. You can also 
choose the Annotations… dialog in the Annotations menu (see 3.9.13 List of 
annotations). 

To discard all defined annotations, defined in all opened patient studies, click at the 
 Clear all annotations icon in the Annotations menu. 

It is also possible to discard annotations in the current image, series or study using the 
respective entries in the Annotations / Delete menu:  

•  Clear all in image icon,  

•  Clear all in series icon, 

•  Clear all in study icon. 
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3.9.13  List of annotations 
Click at the Annotations… item in the Annotations menu to open a dialog with the 
list of all annotations defined in the open studies (see Figure 60). 

The list contains a type, location (series/image) and description of the annotations. 

After selecting one of the annotations and pressing the Go to annotation button, the 
image with the selected annotation will be displayed in the current view. 

By pressing Delete button the selected annotation will be deleted both from the list 
and the image. 

 
Figure 60 Annotations dialog 
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3.10 Play multi-frame images – Cine dialog 
Certain scanning devices (XA, USG, MR, etc.) are capable of capturing the whole 
sequence of image frames in certain time period and store it as one multi-frame image 
(movie). 

TomoCon is capable of displaying the image either frame-by-frame or playing back in 
multi-frame mode (like a movie). To play back multi-frame images in multi-frame 
mode, open the Cine dialog by clicking at the  Cine icon in the Standard toolbar or 
the Cine submenu in the Tools menu (see Figure 61).  

Using this dialog it is possible to control playback of images or a multi-frame image 
in any current view of the workspace (we select current view and in the dialog we 
choose the playback mode, then we select another view and in the dialog we choose 
the playback mode independently for this view). During selection of another current 
view the playback in the view will be kept. 

 
Figure 61 Cine dialog 

The Cine dialog allows: 

• To play images in selected direction : 

o forward , 

o reverse , 

• To stop playing , 

• To play images repeatedly: 

o  in one selected direction (Looping), 

o  back and forth (Sweeping), 

• to change the frame rate - FPS (frames per second), 

• To turn on/off the presentation mode  (see 3.10.1 Full 
Screen/Presentation mode). 
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Figure 62 Cine view playing multi-frame image with ECG curve 

If a multi-frame image contains curves (like ECG), these can be drawn into the image 
selecting the Curves option in the View menu (see Figure 62). While playing, the 
current position in the sequence of frames will be marked with a small vertical line 
inside the curve. 

If the Double click starts/stops playback option is allowed in the TomoCon settings, 
(see 3.2.2 Mouse actions), it is possible to start or stop playback of multi-frame 
image in the current view by simple double click with the left  mouse button. 

3.10.1  Full Screen/Presentation mode  
After pressing the  Full screen icon in the Cine dialog, TomoCon will be switched 
into Presentation mode/Full screen mode, which is adapted for the projection in 
darkened room. 

Full screen Presentation mode contains one view and allows: 

• To play back multi-frame images in multi-frame mode (see 3.10 Play multi-
frame images – Cine dialog),  

• To select series and an image within the chosen series (Series & Image 
selection), 

• Window/Level settings (see 3.4 Window and Level manipulations). 

Press the  icon in the Cine section or the Esc button on the keyboard to quit the 
Presentation mode. 
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Figure 63 Full screen Cine mode 
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3.11 Contouring the patient – create ROIs 
Patient contouring is used with two-dimensional (2D) display for better description 
and better recognition of patient anatomical structures by their coloured outlining in 
the image (see Figure 64). When creating contours on multiple images a ROI (Region 
Of Interest) will be automatically created, which can be later displayed in space in 
three-dimensional (3D) patient presentation. Volume of each ROI (in cm3) is 
calculated automatically. 

 
Figure 64 Defined contour 

Contours and ROIs can be defined using the ROI properties dialog (see Figure 65). It 
can be opened by clicking at the  ROI icon in the Standard toolbar or the ROIs… 
submenu in the Tools menu. 

 
Figure 65 ROI properties dialog, ROIs tab 

The ROI properties dialog allows: 

• To define new ROI – the ROIs tab, the New… button (see 3.11.1 Adding 
new ROI), 

• Automatic segmentation of patient image data – the ROIs tab, the Automatic 
button (see 3.11.2 Automatic contouring), 
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• Automatic contouring of outline surface contours – the ROIs tab, the 
External… button (see 3.11.3 Automatic contouring of outline contours ), 

• To delete the specified ROI from the ROIs list – the ROIs tab, the Delete 
button, 

• To copy ROI between any two registered series – the ROIs tab, the Export 
button (see 3.11.4  Copying ROIs),  

• To export selected ROI into a file – ROIs tab, the Export to file… button (see 
3.11.5  Export ROI to DXF or VTK file), 

• To define chosen ROI properties – the Properties tab (see 3.11.6 Edit ROI 
properties), 

• To define contour – the Contours tab (see 3.11.7 Edit contours). 

3.11.1  Adding new ROI 
Add a new ROI to the list of ROIs by clicking at the New… button in the ROIs tab, 
the ROI properties (see Figure 65). If the current view is empty, the New ROI dialog 
will be opened with the list of series (see Figure 66).  

 
Figure 66 New Region of Interest dialog 

A new line will be added to the list of existing ROIs with name “New ROI …” 
(continuing sequentially within the same series) and some random colour 

.  

The volume calculation is not possible until the ROI is defined in at least one image. 
Each ROI’s volume (in cubic cm) is shown behind its name.  

The check box at the left side of each ROI’s name specifies whether the ROI will be 
displayed in all views. 

NOTE! This process of defining ROI is necessary when adding ROI manually. In 
automatic contouring the ROI is generated automatically (see 3.11.2 Automatic 
contouring and 3.11.3 Automatic contouring of outline contours ). 
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3.11.2  Automatic contouring 
After pressing the Automatic… button in the ROIs tab in the ROI properties dialog 
(see Figure 65) the Threshold dialog for automatic contouring will be opened (see 
Figure 67). 

 
Figure 67 Automatic contouring, Threshold dialog 

The following options are available in the Threshold dialog: 

• Slice box - select the range of images, which are to be used for automatic 
contour search, by selecting an appropriate First slice and Last slice values. 

• Threshold box - select the Minimum and Maximum grayscale values for the 
search process. All grayscale values beginning within the selected threshold 
value range will be considered as matching. You can see this in the current 
view – matching regions are displayed white, the rest is black (see Figure 68). 

 
Figure 68 Segmented image with threshold selection, contouring bones 

It is advisory to check the whole image range by dragging the Slice slider to see 
whether the currently selected Threshold setting delivers expected results and the 
inner parts of the surface are white. Press OK button to start the automatic search 
process (see Figure 69). 
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Figure 69 ROI properties dialog, Automatic contouring 

3.11.3  Automatic contouring of outline contours  
After pressing the External… button in the ROIs tab in the ROI properties dialog 
(see Figure 65) the Threshold dialog for creating outline surface contours - patient’s 
head or body, will be opened (see Figure 70). 

 
Figure 70  External contouring, Threshold dialog 

The following options are available in the Threshold dialog (see Figure 70): 

• In the Slice box, select the range of images, which are to be used for 
automatic contour search, selecting an appropriate First slice and Last slice 
values. 

• In the Threshold box, select the Minimum grayscale value for the search 
process. All grayscale values beginning with the selected minimum value will 
be considered as matching. You can see this in the current view – matching 
regions are displayed white, the rest is black). The largest adjacent area will 
be outlined with contour (see Figure 71). 

 
Figure 71 Segmented image with threshold selection, contouring whole body outline 

It is advisory to check the whole image range by dragging the Slice slider to see 
whether the currently selected Threshold setting delivers expected results and the 
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inner parts of the surface are white. Press OK button to start the automatic search 
process (see Figure 69). 

A newly created ROI is automatically defined as a Series master (see 3.11.6 Edit ROI 
properties). 

3.11.4  Copying ROIs 
ROIs can be copied between any two registered series (see 3.15 Registrations). This 
can visually highlight objects, which are better viewable in another series. 

After selecting ROI in the ROIs, ROI properties dialog and pressing the Export… 
button, the Export ROI dialog will be opened (see Figure 72). Here you can specify 
the target series for the ROI export. In the target series, after pressing OK, a new ROI 
will be created. 

 
Figure 72 Export ROI dialog 

3.11.5  Export ROI to DXF or VTK file 
It is possible to export selected ROI into AutoCAD DXF file or VTK file. After 
selecting ROI in the ROIs, the ROI properties dialog and pressing the Export to 
file… button, the Export dialog (see Figure 72) will be opened. 

 
Figure 73 Export dialog 

Select desired file format, file name and target folder. Press the Save button to 
proceed. 

3.11.6  Edit ROI properties 
Choose ROI from the ROIs, the ROI properties dialog. ROI properties can be 
changed in the Properties tab in the ROI properties dialog (see Figure 74). 
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Figure 74 ROI properties dialog, Properties tab 

The Properties tab has following options: 

• Name – change ROI’s name, 

• Resolution - specifies how fine or coarse the contours are that the ROIs 
consist of. The finer the resolution, the smaller details can be contoured, but 
the graphical performance might decrease on large, complex contours. On the 
contrary, the coarser the resolution, the better graphical performance. Large 
contours (like head, body) will be better smoothed, with less jagged edges on 
image borders, but very small details or objects might partially disappear. The 
ROI object isn’t recalculated immediately. It is necessary to end work in the 
Properties tab to start the process. The calculation will be finished by 
choosing another tab; 

• Closure - selects whether the ROI is displayed in 3D view: 

o Open (open from the top and the bottom), 

o Closed (from the top and the bottom), 

o Top open, 

o Bottom open, 

• Clipping - specifies whether the part of ROI closer to the user will be cut off 
in 3D view by chosen MPR plane,  

• External - specifies the chosen ROI as “Master” for clipping the MPR planes 
(see 3.14.1 3D View settings). There can be only one “Master” ROI per series, 

• Drawing mode - specifies the art of displaying the ROI in 3D view: 

o  Solid – ROI will be displayed as an opaque object. Clicking at the ROI 
object surface delivers a new current point position. 
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o Transparent – ROI will be displayed as a transparent object with 
selectable transparency ratio. NOTE! It is not possible to obtain a current 
point position by clicking at the transparent object surface! (Transparent 
objects are considered as not having a surface.) Surface position of the 
nearest solid object behind will be taken instead. 

o Stripes – ROI will be displayed as a set of contours (wire-frame model). 

o Transparent with stripes – ROI will be composed from transparent 
object and a set of contours. 

• Color – ROI color settings. 

• Opacity - describes transparent ROI’s opacity. The higher percentage, the 
more opaque the ROI is. 

3.11.7  Edit contours 
ROI consist of separate contours, which can be manually edited after switching to the 
Contours tab (see Figure 75), ROI properties dialog.  

There are three main edit tools available:  

• Freehand – contour the area with free hand, 

• Polygon – contour the area using a polygon, 

• Magic Wand – contour the area by joining adjacent image pixels with similar 
gray level values with following options: 

o 3D, contour with selected gray level values in selected image will be 
applied to remaining images in the series, 

o Holes, image areas inside the region with different gray values will be 
contoured to mark holes in the final contoured area, 

o Single polygon, only one compact polygon from contoured region will 
be chosen as final contoured area. 
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Figure 75 ROI properties dialog, Contours tab 

In combination with two basic editing modes: 

• Add 

• Remove 

there are 6 modes in creating contour available (indicated by cursor shape): 

•  Freehand / Adding - outline contour by dragging the cursor with primary 
mouse button pressed. The first  and the last line point will be connected to 
form a closed contour after you release the primary mouse button. The area 
covered by the line will form a new contour or will join the existing contour; 

•  Freehand / Removing – remove a part of existing contour by dragging the 
cursor with primary mouse button pressed around the area you want to 
remove. The overlapping areas will be removed; 

•  Polygon / Adding - outline contour point by point. The clicked points will 
be connected with straight lines. The polygon area will be closed after clicking 
to a position close to the first contour point  (mouse cursor icon will get 

shape). The area covered by the polygon will form a new contour or will 
join the existing contour; 

•  Polygon / Removing – remove a part of existing contour. Outline the area 
point by point that should be removed. The overlapping areas will be removed; 

•  Magic Wand / Adding – press the primary mouse button inside the solid 
area (bone, tissue) and move the mouse (moving the mouse will modify the 
gray similarity factor), image pixels with similar gray level values as the 
clicked point will form a region. After you release the primary mouse button, 
the region will be contoured. The contoured area will form a new contour or 
will join the existing one; 
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•  Magic Wand / Removing - press the primary mouse button inside the 
solid area (bone, tissue) and moving the mouse (moving the mouse modify 
gray similarity factor), image pixels with similar gray level values as the 
clicked point will be removed.  

When editing contour, an infinite “undo buffer” is available. Press the Undo button 
(repeatedly) to revert the last steps. After reverting the steps with the Undo function, 
it is still possible to follow the changes by pressing the Redo button. 

Press the Delete button to remove the contour from the current image. 

To continue to another image, change the current image by clicking at a chosen 
thumbnail preview, press the Prev or Next button or scroll the mouse wheel. 

It is possible to copy the contour from the previous or following image into the 
current image. Choose an adjacent image, come back to the current one and pres the 
Copy Last button. The contour will be copied. This is useful if you draw contours 
sequentially in more images and the contours need only slight changes. 
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3.12 MPR – Multi Planar Reformatting 
MPRs show sections in patient's body using the defined plane. They are calculated 
from the original images of the selected series. The MPR dialog (see Figure 76) 
allows defining MPR plane in the current view. 

NOTE! Diagnosing users should be aware that MPR views display calculated data. 
Calculated data, although based on the original data set, may give the appearance of 
healthy tissues in situations, where pathology, which is smaller than the image 
distance, may be present. Occasionally, calculated data may also include image 
artifacts, which should not be interpreted as real pathology. 

The MPR dialog (see Figure 76) can be opened by clicking at the  MPR icon in 
the Standard toolbar or the MPR… submenu in the Tools menu. 

 
Figure 76 MPR dialog 

MPR dialog allows displaying MPR in the current view using the following 
characteristics (in the current view an image from the series must be displayed for the 
MPR calculation): 

• Series selection, 

• MPR plane selection: 

o Axial - xy plane, 

o Sagittal – yz plane,  

o Coronal – xz plane,  

o Arbitrary (see 3.12.1 Arbitrary ), 

• Display a rotation tool to help with the MPR rotation – Orbit (see 3.12.1 
Arbitrary ), 

• Online – MPR to be bound to the current point (see 3.12.2 Online MPR), 

The MPR dialog, using the Multiplanar button, allows to create a set of three 
mutually perpendicular online MPR views. 

For better spatial orientation, small box-like indicator in the upper right corner of the 
MPR view displays the approximate position and orientation of the MPR plane in 
patient image data. 
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While the MPR dialog is opened, the position of the plane in the current view is 
indicated by a coloured line (see 3.2.5 Color settings) in all images and thumbnails, 
which are intersected by the MPR image plane (see Figure 77). 

3.12.1  Arbitrary MPR 
MPR is not necessarily oriented parallel to main patient axes. It can be rotated into 
any orientation. This can be done by clicking at the  MPR rotate icon (in the 
context menu or in the Context toolbar) and moving mouse with pressed primary 
mouse button directly in the current view. Base MPR plane (axial, sagittal or coronal) 
will be change to Arbitrary plane in MPR dialog. 

To help with the image rotation, select the Orbit checkbox. MPR view will be 
overlaid by set of blue circles that mark image areas with different rotation 
functionality. Check the mouse cursor when it hovers over these areas ( , , ). It 
describes the rotation axis, which will be used if the primary mouse button is used to 
rotate the plane. 

3.12.2  Online MPR 
The Online checkbox in the MPR dialog defines the online MPR to be bound to the 
current point (see Figure 77). All online planes are automatically shifted to intersect 
the current point. If the current point is changed by clicking into one of the views, all 
online planes will be immediately shifted. 

 
Figure 77 Arbitrary MPR view and intersected axial MPR plane 
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3.13 DRR Reprojection  
To create DRR (Digitally Reconstructed Radiograph) reprojection from the patient 
image data, click at the DRR… submenu in the Tools menu (see Figure 78). 

  
Figure 78 DRR Reprojection image and dialog 

DRR parameters in the DRR dialog: 

• Series – choose the image series to create DDR from, 

• Viewport settings – setting up the DDR position to the patient’s position: 

o Anterior, 

o Right, 

o Top, 

o Arbitrary – DDR position using the following parameters: 

 View – view position, 

 Target – DRR target position, 

• Window size. 

Press the Update button to display the created DRR to the current view. 
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3.14 Three-Dimensional Visualization  
Image data analysis can be simplified if the objects are displayed in 3D rendered 
views. To display 3D objects it is necessary to define ROIs (see 3.11 Contouring the 
patient – create ROIs). This process is called segmentation. 

3.14.1  3D View settings 
The 3D view dialog (see Figure 79) will be opened by clicking at the  3D icon in 
the Standard toolbar or the 3D view… submenu in the Tools menu. 

 
Figure 79 3D view dialog 

Three-dimensional view of the patient image data from the current series will be 
opened in the current view (see Figure 80). 

If no ROIs are defined in the series or the current view is empty, the 3D display will 
be empty.  

There are following options available in the 3D view dialog: 

• Series selection, 

• MPR – MPR plane settings in the 3D view: 

o Clip to - select ROI to be used to limit the clipping MPR bitmap. The ROI 
is marked with ‘*’ in front of its name, 

o Choose a plane, the chosen planes are highlighted with a green rectangle: 

 Axial, 

 Sagittal, 

 Coronal, 

o Online – MPR to be bound to the current point, NOTE! It is possible to 
click somewhere at the displayed 3D data to define a new current point. If 
the black background is clicked, the current point will not change. It is not 



TomoCon 3.0 User’s Manual 

 

70 

possible to obtain the current position by clicking at the transparent 
object’s surface! Surface position of the nearest solid object behind will be 
taken instead. Transparent objects are considered as not having a surface; 

• View – 3D view options: 

o Bounding volume - optically marks patient image data with a transparent 
gray box, 

o Orbit – in 3D view, MPR view will be overlaid by set of blue circles that 
mark image areas with different rotation functionality (see 3.14.2 
Rotation, spatial orientation), 

o Registered ROIs – display ROIs from different registered series (see 3.15 
Registrations), 

o Fast drawing - while rotating, moving or zooming the 3D image all ROIs 
are temporarily displayed in Stripes mode. Stripes mode is much easier to 
operate with; rotating, moving or zooming is realized much faster 
(recommended on slower computer hardware). 

Different ROI display options can be found in 3.11.6 Edit ROI properties. 

 
Figure 80 3D view 

3.14.2  Rotation, spatial orientation 
3D view can be rotated with primary mouse button pressed; click at the  Rotate 
item in the 3D view’s context menu or in the Context toolbar and use the mouse 
directly in the 3D view window. Mouse cursor will get  form. 

To help with the image rotation, after selecting the Orbit checkbox, 3D view will be 
overlaid by set of blue translucent spheres (see Figure 81). These mark image areas 
with different rotation functionality – check the mouse cursor when it hovers over 
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these areas ( , , ). It describes the rotation axis, which will be used if the 
rotation mouse button is used to rotate the displayed data. 

 
Figure 81 3D view with Orbit function 

To return to the initial viewing angle and zoom, select the Reset view in the 3D 
view’s context menu. 

For better spatial orientation, a small robot-like icon (called Enrico) is displayed in a 
chosen corner of 3D view. In correct cases, its orientation should match the patient’s 
orientation. If its appearance should be disturbing, it can be hidden in the TomoCon 
setup dialog (see 3.2.3 Displayed texts in views ). 

3.14.3  Moving MPR plane 
It is possible to move MPR plane interactive in the view. When mouse goes over an 
edge of the MPR plane, cursor will change to  and the border of the MPR plane is 
highlighted to yellow (see Figure 82). Then press primary mouse button and move 
mouse to move the MPR plane. 

 
Figure 82 3D view with highlighted MPR plane 
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3.15 Registrations 
To map one series onto another and define a relation between them, they have to be 
registered (matched one to another). It is then possible to transfer coordinates between 
the series bi-directionally, to check the same position in two series and to display the 
data overlaid from both series in the Image fusion mode (see 3.16 Image fusion). 

The Registrations dialog (see Figure 83) will be opened by clicking at the 
Registrations… submenu in the Tools menu. 

   
Figure 83 Registrations dialog 

The following actions are available in the Registrations dialog: 

• New… - define new registration between two series (3.15.1 Defining the 
registration), 

• Edit... – edit the chosen registration, 

• Delete… - delete selected registration from the list of registrations, 

• Show Frame of reference registrations – hide/display registrations between 
two series – if a Frame of reference is defined in patient data. When opening 
patient study (with the Frame of reference) the registration will be created 
automatically between the two series. 

It is possible to define multiple registrations between two series. In this case, only one 
of them may be active (marked with green color and checked). Other registrations 
between the series are inactive (marked with red color and unchecked). Using the 
checkbox, it is possible to undefine temporarily a registration or to select one of the 
registrations defined for a pair of series. 

3.15.1  Defining the registration 
Press the New… button in the Registrations dialog (see Figure 83) to define the 
relation between two series. The Define registration dialog will be opened (see 
Figure 84). 



TomoCon 3.0 User’s Manual 

 

73 

 
Figure 84 Define registration dialog, selecting Registration type 

The Define registration dialog (see Figure 84) specifies: 

• Series - two series and the registration type between them: 

o From series, 

o To series, 

• Registration types: 

o Identity (see 3.15.1.1 Identity), 

o CA-CP (see 3.15.1.2 Patient-related (CA-CP)), 

o Surface matching (see 3.15.1.3 Surface matching), 

o Landmark (see 3.15.1.4 Landmark), 

o Manual (see 3.15.1.5 Manual), 

o MIR (see 3.15.1.6 MIR) 

3.15.1.1 Identity 
Identity registration assumes that the coordinate systems of the two image series are 
equal and exact. Use this option, if patient coordinate systems have been established 
in both image series (Frame of reference has been defined) or if with other means the 
coordinate systems were kept identical. 

3.15.1.2 Patient-related (CA-CP) 
CA-CP registration (see Figure 85) uses the coordinates of patient’s CA, CP and 
Median points to establish a series registration. 

The distance between CA and CP points must lie between 21.0 and 28.5 mm. 
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Figure 85 CA-CP Registration dialog 

3.15.1.3 Surface matching 
Surface matching registration (see Figure 86) uses ROIs to establish a series 
registration. It is suitable for cases where the same structure ROI was defined in both 
image series. These two ROIs will then be matched. 

   
Figure 86 Surface Matching Registration dialog, Surface matching settings dialog, 

Registration results – Distances dialog 

3.15.1.4 Landmark 
Landmark registration (see Figure 87) uses the coordinates of several landmarks to 
establish a series registration. 

 
Figure 87 Landmark Registration dialog 

Wrong landmark twins with error exceeding an acceptable value can be disabled 
without deleting them from the list by unmarking  in the check box. 
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Landmarks may be renamed according to the names of the marked significant points. 
Simply click at the landmark name (default automatic names are L1, L2, etc.) and 
overwrite it to match the marked structure or pin (e.g. Marker2). All enabled 
landmarks are displayed in the image  with their respective name. 

3.15.1.5 Manual 
Manual registration of two different series uses relative manual movement of their 
three base planes. After selecting manual registration in the Define registration 
dialog, the Manual registration initialization dialog will be displayed (see Figure 
88) for initial settings of manual registration. In this dialog we can define one of these 
starting relations between the series: 

• Use existing registration (select existing registration from list),  

• Automatic (centres of 3D coordinate systems of both series will be assumed 
identical). 

 
Figure 88 Manual registration initialization dialog 

After confirming the initial step with OK button three views for manual registration 
will be displayed in workspace (see Figure 89) together with the Manual registration 
dialog (see Figure 90). The registration layout contains three independent views, 
every view displaying a pair of MPRs (every MPR is for different series) in one base 
plane (axial, sagittal, coronal). MPRs of registered series have different colors and 
they are transparent. The color of each series’ MPRs is displayed in Manual 
registration dialog and it is anytime possible to change it. 
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Figure 89 Manual registration working area layout 

 
Figure 90 Manual registration dialog 

Activate the first view. A circle for moving and rotating the MPR will be displaying 
in this view. When the mouse cursor lays inside the circle, we can move the MPR 
(cursor has  figure). Press the primary mouse button, move the MPR to required 
place in view and release the mouse button (see Figure 91 a). Out of this circle we can 
rotate MPR around the centre of view (cursor has  figure). Press the primary mouse 
button, rotate the MPR to required orientation in view and release the mouse button 
(see Figure 91 b). We can only move/rotate MPR of one series. MPRs of the second 
series (called Base MPR) are left unchanged in view. After releasing mouse button the 
registration is automatically recalculated and the remaining views are automatically 
redrawn. 

While editing the manual registration, it is anytime possible to enter the move and 
rotate mode by pressing the  button (e.g. other operation type is used in the view). 
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        (a)                                  (b) 

Figure 91 Pan (a) and rotate (b) MPR during manual registration 

If necessary it is possible to modify the plane of the Base MPR in any view. Activate 
a view, where the MPR plane should be changed and press the  button in the 
Manual Registration dialog. MPR will be displayed in the current view (see Figure 
92 a), which can be moved and rotated (standard MPR display, see 3.12 MPR – 
Multi Planar Reformatting). After pressing the  button once more it is possible to 
continue editing the manual registration view (see Figure 92 b). 

While editing the manual registration, it is anytime possible to revert to initial 
registration settings by pressing the Reset button in the Manual Registration dialog. 

After successfully defining the manual registration by pressing the OK button the 
registration will be added to the list of existing registrations. Otherwise, after pressing 
the Cancel button, the registration will be discarded and will not be used. 

               
        (a)                       (b) 

Figure 92 Moving the Base MPR’s plane (a), manual registration with shifted plane of 
the Base MPR (b) 
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3.15.1.6 MIR 

 
This functionality is available only in TomoCon Advance WS. 

 
MIR (Mutual Information Registration) is probability method for calculation of 
registration between two series, where the final registration is calculated 
automatically. 

After selecting MIR registration in the Define registration dialog, the Registration 
Initialization dialog will be displayed (see Figure 93) for initial settings of MIR 
registration. In this dialog we can define one of these starting relations between the 
series: 

• Use existing registration (select existing registration from list),  

• Automatic (centres of 3D coordinate systems of both series will be assumed 
identical). 

 
Figure 93 MIR registration initialization dialog 

After confirming the initial step with OK button, a Mutual Information 
Registration dialog will be displayed (see Figure 94). Calculation of the registration 
is started by pressing the OK button (registration progress will be displayed in log 
window). 

 
Figure 94 MIR Registration dialog 

Advance settings for the MIR registration can be changed in the Mutual Information 
Registration – Advanced Options dialog. After clicking the Advance Options 
button, a dialog will be opened (see Figure 95), where we can define all advanced 
settings of the registration process. 
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Figure 95 Mutual Information Registration – Advanced Options dialog 

3.16 Image fusion 
Image fusion allows displaying the data from two registered series combined or 
overlapped in one image view (see 3.15 Registrations). 

These series may contain different kinds of information, for example CT scans with 
contrast media and without it, MRI series taken with different parameters, scans 
before the treatment and after the treatment, PET scans and others. 

The Image fusion dialog (see Figure 96) will be opened by either clicking at the  
Fusion icon in the Standard toolbar or Image fusion… submenu in the Tools menu. 

 
Figure 96 Image fusion dialog 

Fusion settings using the Image fusion dialog: 

• Series – registration series: 
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o Base, 

o Fusion - the overlaid series, 

o Registration type – registration type will be set automatically depending 
on currently using registration for the chosen series (see 
3.15. Registrations), 

• Type – type of image fusion between base and fusion series: 

o Vertical – the view is divided by a vertical line, image from the fusion 
series is on the right side (see, right), 

o Horizontal – the view is divided by a horizontal line, image from the 
fusion series is at the bottom, 

o Rectangle – the image from overlaying series is inside the rectangle (see 
Figure 97, left), 

o Edit – after choosing this option (or double-clicking at the separating line 
or inside the rectangle) and holding primary mouse button drag the 
rectangle, its frame or border to modify the border position, rectangle 
frame position and its size, 

o Flip – invert fusion,  

• Translucency – basic fusion transparency settings using a slider from 0 % 
(the fusion series is transparent) to 100 % (the fusion series is opaque). 

 
Figure 97 Fusion images between MR and PET series 
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3.17 DSA – Digital Subtraction Angiography 
The DSA mode supports displaying multi-frame images with image sequence taken 
with the contrast media and without it. The final DSA image is then displayed as a 
difference between the base image (with the contrast media) and mask image (without 
the contrast media). To separate the base and mask images, use the following modes: 

• Automatic – the images contain DICOM information from the patient 
examination and the separation is realized automatically after opening the 
patient in TomoCon (see 3.17.1 Automatic DSA mode), 

• Manual – the image separation has to be made manually (see 3.17.2 Manual 
DSA mode). 

3.17.1  Automatic DSA mode 
Open a patient study with a multi-frame image containing DICOM information about 
DSA examination. After displaying this image, depending on the 
View/Controls/Always apply DSA settings in the TomoCon setup dialog (see 3.2.1 
Setting up the application), DSA mode is turned on automatically in all views for all 
image types. After selecting the image into the current view all modification available 
in the application can be used to work with the image (see Figure 98).  

 

Native view of DSA 
image in thumbnail 

view 

Apply DSA mode 
to the image 

DSA mode activated 
in the current view

 

Figure 98 Automatic DSA mode 
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DSA mode in the current view can be turned off using the view’s context menu. Click 
at the DSA item. The changes made in the current view can be applied to the image’s 
thumbnail preview by pressing Apply in the current view’s context menu. Apply the 
changes to all images in the current series by clicking at the Apply to all item in the 
current view’s context menu. 

3.17.2  Manual DSA mode 
Open a patient study containing a multi-frame image without DICOM information 
about DSA examination. Choose the multi-frame image in the current view. Click at 
the DSA… item in the Tools menu to open the DSA dialog. Choose the DSA Manual 
mode. A dialog will be opened for DSA parameters settings (see Figure 99): 

• Mask frame - starting image number in the mask (image sequence without the 
contrast media): 

o Static mask – mask frame is static for all chosen frames, 

o Dynamic mask – mask frame is changed dynamically according to the 
chosen current frame, 

• Applicable frame – image sequence with the contrast media covered with the 
mask image(s): 

o Start – first sequence image number, 

o Count – number of sequence images, 

• Alignment – move the mask image relative to the base image: 

o U – up, 

o L – left, 

o R – right, 

o D – down, 

o C – centre, original position. 

The changes will be applied to the image in the current view immediately. Similarly 
to the automatic DSA mode, the DSA settings in the manual DSA mode can be 
applied to the image and the thumbnail preview. 

Switch automatic DSA mode of the image with DICOM information to manual 
wherever appropriate. DSA setting changes can be made using the DSA dialog. To 
return to the original settings, click at the Auto mode item and the settings will return 
to the image original DICOM setting. 
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Manual mode 
activated Set up the mask image 

Dynamic mask 

Define range of applicable 
frames by start frame and 

count of frames 
Mask image move 

buttons 

Static mask 

 

Figure 99 Manual DSA mode 
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3.18 Cutlines 
Cutlines are intersections of slice planes in one series with a plane of a chosen image 
from another series where they are displayed. 

The Cutlines function can be used in CT and MR studies only if there are 
registrations created between these studies (see 3.15 Registrations). 

Open a patient study with more series and registrations between them. Choose an 
image in the thumbnail palette where the Cutlines should be displayed. Click at the 
Cutlines option in the view’s context menu or the View menu/Cutlines to activate the 
Cutlines function (see Figure 100). 

 
Figure 100 View/Cutlines menu 

Choose a patient series from the Cutlines menu. The Cutlines of chosen series will be 
immediately displayed in the current view, called standard Cutlines (if the planes are 
not parallel). Standard cutlines are displayed as lines with series and image 
description (see Figure 101). Set up the Cutlines color and the line shape in the 
application settings (see 3.2.5 Color settings). 

Load an image from the chosen series into another view; its position will be displayed 
in the view with displayed Cutlines (current cutline). The current cutline is displayed 
as a line; set up the color and the line shape in the application settings (see 3.2.5 
Color settings). The cutline will be automatically changed when choosing another 
image of the chosen series. They will be also displayed when scrolling the images of 
the series with displayed cutlines (if the planes are not parallel). 

It is possible to present cutlines of more series in one image. Choose series you want 
to display in the image in the Cutlines menu. 
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It is also possible to display cutlines in more views at a time (see Figure 101). In each 
view, click at the context mouse button; choose Cutlines and the registered series. 

When the cutlines can not be displayed, it means:  
• There are no registrations defined between the series, 
• Section planes are parallel (they do not intersect). 

 
Figure 101 Displayed cutlines at the working area 

3.18.1  Delete cutlines 
The None option in the Cutlines menu (see Figure 100) is predefined, that means no 
cutlines will be displayed. Once the cutlines have been activated, click at None to turn 
the displayed cutlines off. (Click at the context mouse button, choose Cutlines/None). 

It is also possible to turn Cutlines off by clicking at the chosen series in the Cutlines 
menu. 

3.18.2  Auto mode 
Click at the right mouse button in the current view and choose Cutlines/Auto from 
the context menu (see Figure 100). Open an image from any patient series in a new 
window. The cutlines of the new series will be displayed automatically in the view 
with the Auto mode. The chosen image will be displayed as a current cutline. Current 
cutlines will be changed automatically when changing an image in the current view. 

3.18.3  Print and save cutlines 
Defined cutlines can be printed out with the image on a standard MS Windows printer 
(see 3.19 Print images on a MS Windows printer) and a DICOM printer (see 3.20 
Print images on a DICOM printer). When closing a patient study, cutlines will not 
be saved. 
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3.19 Print images on a MS Windows printer 
Patient image data can be printed on a MS Windows printer using the Print dialog 
(see Figure 102) that will be opened by clicking at Print… in TomoCon menu. 

It is possible to choose from following settings in the Print dialog: 

• Printer Name, 

• Margins, 

• Print: 

o Working area, 

o Whole series: 

 Number of rows, 

 Number of columns. 

Note! Do not forget to select an appropriate paper orientation and other preferences in 
the Properties… dialog. 

Set up the parameters, press the OK button; the printing process will start. 

 
Figure 102 Print dialog 
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3.20 Print images on a DICOM printer 
 

This functionality is not available on MS Windows 98 SE. 
 

Patient image data can be printed on a DICOM printer using the DICOM print 
interface (see Figure 103) that will be displayed after pressing the DICOM print... 
submenu in TomoCon menu.  

 
Figure 103 DICOM print interface 

DICOM print interface consists of: 

• Working area (see 3.20.1 DICOM print working area), 

• Thumbnail palette (see 3.20.2 DICOM print thumbnail palette), 

• Menu (see 3.20.3 DICOM print menu), 

• Standard toolbar (see 3.20.4 DICOM print standard toolbar), 

• Status bar (see 3.20.5 DICOM print status bar). 

3.20.1  DICOM print working area 
DICOM Print working area is a big black area representing one print film. It is similar 
to the TomoCon’s working area. It is divided into smaller windows (views) depending 
on row and column settings in the Print properties dialog, Image Display Format 
(see 3.20.7 Setting up DICOM print interface properties).  

Use the mouse to move between the views, the current view is highlighted in a 
colored frame (see 3.2.5 Color settings). Use the actions in the DICOM Print view’s 
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context menu, Standard toolbar (see 3.20.4 DICOM print standard toolbar) or 
program menu (see 3.20.3 DICOM print menu) to operate with the image in the 
current view. 

3.20.2  DICOM print thumbnail palette 
The thumbnail palette is located at the right side of the DICOM print interface (see 
Figure 103) and it is a copy of a thumbnail palette in the application. All series of 
opened studies in TomoCon are displayed in the palette and the work with it is 
identical to the work with thumbnail palette in TomoCon (see 3.1.4.2 Thumbnail 
palette). 

3.20.3  DICOM print menu 
DICOM Print menu is located as a DICOM Print window system menu (see Figure 
103). It has following sub menus: 

• File – DICOM printer installation (the Printers… submenu, see 3.20.6 
DICOM printer ); end work in DICOM Print interface (Exit), 

• Images – image modification in the current view (see 3.20.8 Edit images), 

• Selection – choose images from the thumbnail palette to the working area 
(see 3.20.9 Images for print), 

• Film – edit and move between the films (see 3.20.10 Edit and move films), 

• View – hide/display: 

o Toolbar, 

o Status bar, 

o Thumbnail palette, 

o Print properties dialog, 

• Help (see 3.1.5.9 Help menu). 

3.20.4  DICOM print standard toolbar 
The Standard toolbar (see Figure 104) is located under the DICOM Print interface 
system (to display/hide the dialog see 3.20.3 DICOM print menu, View/Toolbar). 
The Standard toolbar contains: 

• Tools for changing gray, window and level in the current view (W/L, W/L 
rect.), 

• Tools for image zooming in the current view (Zoom, Zoom rect.), 
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• Tools for moving the image in the current view (Move). 

Activation and using the tools is identical to the tools of TomoCon toolbars (see 
3.1.4.4 Toolbars): 

• Move to the previous film (Previous),  

• Move to the next film (Next), 

• Select all images in the thumbnail palette (Select all), 

• Deselect all chosen images in the thumbnail palette (Deselect all), 

• Invert the chosen images from the thumbnail palette (Invert), 

• Add all chosen images from the thumbnail palette to the working area (Add), 

• Display/hide the Print properties (Print) dialog, 

• Display DICOM printers installation dialog (Printers). 

 
Figure 104 DICOM print standard toolbar 

3.20.5  DICOM print status bar 
The Status bar is located at the bottom of the DICOM Print interface (to hide/display 
the dialog see 3.20.3 DICOM print menu, View/Status bar). If the user selects a 
menu or a button from the toolbar, its description appears on the left side of the status 
bar (instead of the “TomoCon 3.0 Ready” text). The number of the current film is 
displayed on the right side of the status bar which represents the DICOM Print 
interface working area. 

3.20.6  DICOM printer installation 
Use the Printers dialog (see Figure 106) to install a DICOM printer. Click at the 
File/Printers... in the DICOM print interface program menu to open the dialog (see 
Figure 105). 

 
Figure 105 File menu  
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Figure 106 Printers dialog 

The Printers dialog contains a list of installed DICOM printers. It is possible to 
configurate them using the Configuration dialog of a chosen printer (see Figure 107) 
that will be displayed after clicking at the Configure... button. Using the Verify 
button it is possible to test the connection between TomoCon and the chosen DICOM 
printer. Use the Delete button to delete a printer from the list. 

  
Figure 107 Printer configuration dialog 

To install a new DICOM printer click at the Install... button to open the Printer 
installation dialog (see Figure 108). Specify the new printer’s properties: 

• Printer name, 

• Hostname, 

• Port, 

• Printer AE title, 

• Calling AE title. 

 
Figure 108 Printer installation dialog 
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3.20.7  Setting up DICOM print interface properties 
Use the Print Properties dialog to set up DICOM Print interface preferences (to 
display/hide the dialog see 3.20.3 DICOM print menu, View/Print properties). 
This dialog is placed on the left side of the working area. It can be docked anywhere 
inside the area same way as the thumbnail palette.  

Using the Print properties dialog (see Figure 109) it is possible to set up the 
following DICOM Print interface properties: 

• Choose a printer from the list of installed printers (Printer), 

• Number of rows and columns in the working area that match image layout in 
the film (Image Display Format), 

• film properties: 

o type (Medium), 

o Destination, 

o Orientation, 

o Size, 

• Printer resolution in DPI (Resolution), 

• Number of film copies (Copies). 

 
Figure 109 Print properties dialog 

Press the Print button when the film is ready for printing. The DICOM print dialog 
shows the current state of print (see Figure 110). 
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Figure 110 DICOM printing…  

3.20.8  Edit images 
Images in the working area can be edited the same way as the images in TomoCon. 
Using the Images menu (see Figure 111) it is possible to make following 
modifications of the image data in the current view: 

• Window/Level, Window/Level rectangle, 

• Zoom, Zoom Rectangle, 

• Move. 

Activation and using the modifications is identical to the options of TomoCon’s 
Image menu (see 3.1.5.4 Image menu). 

Using the menu it is also possible to display/hide the following information in all 
images on the films of the DICOM Print interface: 

• Texts, 

• Ruler, 

• Curve, 

• Shutter, 

• Overlay 

• Annotations. 

 
Figure 111 Images menu 
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3.20.9  Images for print 
Choose images for print in the DICOM Print interface from the thumbnail palette 
where all series are located. Use the Selection menu to choose the images and add 
them to the film (see Figure 112). 

 
Figure 112 Selection menu 

The Selection menu allows to: 

• Choose all images displayed in the thumbnail palette (Select all), 

• Cancel the choice of all images from the thumbnail palette (Deselect all), 

• Invert the selected images (Invert selection), 

• Add chosen images from the thumbnail palette to the film (Add selected), the 
images will be added to the end of the film/films behind the already chosen 
images. 

3.20.10  Edit and move films  
When starting the DICOM Print interface an empty film without images is available. 
After adding the images these are placed one after another to the required number of 
films. The DICOM Print working area represents one film. Number of images on the 
film is specified by number of rows and columns in the Print properties dialog in the 
Image Display Format option.  

Use the Film menu to edit and move films (see Figure 113): 

• Move to the next film (Next), 

• Move to the previous film (Previous), 

• Delete an image in the current view (Delete image). Images following the 
deleted image will be replaced in one position; 

• Delete film and Delete all films. 

 
Figure 113 Film menu 
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3.21 Touch screen mode 
 

This functionality is not available on MS Windows 98 SE. 
 

TomoCon offers a special touch screen mode for touch screens used in operating 
rooms. The touch screen mode will be activated directly when starting TomoCon (see 
3 TomoCon description) or during the work with the application choosing the Touch 
screen mode item in the Tools menu. The mode offers chosen functions from the 
application; these are operated using enlarged control buttons. 

The touch screen mode window consists of two parts (see Figure 114): 

• Working area (left), 

• Panel with control buttons (right). 

When starting the mode the working area has only one view, the current view. Press 
the  button to change the working area layout (see 3.21.5 Working area layout). If 
there are more views in the working area, choose any view to become the current one. 
If patient studies were opened in TomoCon before switching to the touch screen mode 
and the current view was empty, the working area will be filled with the image 
sequence. The first image will be the first image from the last series of last opened 
study in TomoCon. If there was an image chosen in the current view, the working area 
will be filled with the image sequence from the current image series beginning with 
this image. If no patient study was open, the working area will be empty. 

 
Figure 114 Touch screen mode – layout 

Control buttons panel is divided to 3 parts: 

1. The top part of the panel contains the following buttons: 
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o Open a patient study  (see 3.21.1 Open a patient study), 

o Close a patient study  (see 3.21.2 Close a patient study), 

o Exit the touch screen mode , 

o Choose image series: 

  - Move to the previous series, 

  - Move to the next series 

(The series are in the same order as they were opened in TomoCon), 

o Move the images within the series: 

  - Move to the previous image, 

  - Move to the next image, 

2. The middle part of the panel contains the following tabs: 

o  - Window, level, shape settings (see 3.21.3 Window, level, shape 
settings), 

o  - Move and zoom images (see 3.21.4  Move and zoom images), 

o  - Working area layout settings (see 3.21.5 Working area layout), 

o  – Switch to the Cine mode (see 3.21.6 Play multi-frame images), 

3. The bottom part of the panel contains buttons connected to the action chosen. 

3.21.1  Open a patient study 

In the Touch screen mode a patient study will be open after pressing the  button. 
The Search studies dialog will be opened (see 3.3 Open a patient study).  

3.21.2  Close a patient study 

All studies opened in TomoCon can be closed by pressing at the  button. If the 
Touch screen mode was activated while working with the application and changes 
were made (ROI, registrations, annotations), a dialog will be open allowing to save 
the changes before closing the studies (see Figure 131). 

3.21.3  Window, level, shape settings 

Choosing the  tab the following buttons will be displayed at the bottom part of the 
panel (see Figure 115): 
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•  – accelerating level increase, 

•  – accelerating level decrease. 

 The following levels will be changed in the all images of the working area: 

• Window – , 

• Level  – , 

• Shape  – . 

Level changing process is indicated by the slider and numeric values under the sliders.  

At the bottom of the panel, the button allowing following actions are located: 

•  – invert the colors in the image, 

•  – reset default values of window, level a shape in the series, 

•  – apply new values of window, level and shape to the series. 

 
Figure 115 Touch screen mode - gray, W&L settings 

3.21.4  Move and zoom images 

Choosing the  tab the following buttons will be displayed at the bottom part of the 
panel (see Figure 116): 
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Figure 116 Touch screen mode – move and zoom images 

• Zoom the image in the working area from 50 % to 800 %: 

o  – zoom out, 

o  – zoom in 

     (The current image size is listed under the zooming buttons), 

• Move the image: 

o  – up, 

o  – down, 

o  – left, 

o  – right, 

• Return to the default size and position - . 

3.21.5  Working area layout 

Choosing the  tab the buttons representing the working area layout will be 
displayed at the bottom part of the panel (see Figure 114). 

3.21.6  Play multi-frame images 

Choosing the  tab the following buttons will be displayed at the bottom part of the 
panel (see Figure 117): 

• Play back the images: 

o  – play backward, 
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o  – play forward, 

o  – stop playing back the images, 

(When playing back the images, only one view will be displayed in the 
working area where the images starting with the current image will be 
played back; the slider and numeric value under the buttons indicates the 
displayed image position in the series), 

• Playing mode: 

o  – looping, 

o  – sweeping. 

• Change frame per second (fps) from 0 to 50 fps with 2,5 step: 

o  – increase fps, 

o  – decrease fps, 

(the current speed value is listed between the buttons). 

 
Figure 117 Touch screen mode – playback multi-frame images 
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3.22 Structured reports 
Structured reports are used to write medical reports, findings and other reports 
referring to a patient study or an image. 

Click at the Study menu, Reports... to open the Reports... dialog (see Figure 118). 

The Reports... dialogs can be resized and relocated anywhere inside the application. 

 
Figure 118 Reports dialog 

3.22.1  Create a new report 
To create a new report click at the Study menu, Reports…. 

A new report will be created only if there is a study opened in TomoCon.  

When opening study of patient with no image data available (Open study, Search 
studies) and already created structured report, the Reports... dialog will be opened 
automatically.  

When there is study of another patient opened in TomoCon, the Reports... dialog will 
be opened after clicking at the Study menu, Reports…. 

If there is only one patient opened in TomoCon, after clicking at the  Create new 
report icon in the Reports... dialog an editing dialog will be opened with the patient’s 
name in the heading. When there are more studies opend in TomoCon, the Select 
study... dialog will be opened. After choosing a patient and pressing the OK button 
the Report dialog will be opened (see Figure 119). 

 
Figure 119 Report dialog 

Click at the  Add new section icon on the left side of the dialog or choose Add 
new section in the Report dialog context menu (click the right mouse button inside 
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the dialog). A menu will be displayed with paragraph types that can be added to the 
text of the edit dialog (see Figure 120): 

• Text – subtitle, report text, 
• Container – contains text or another container (max 64 elements), 
• Concept modifier – specifies the report heading,  
• Observation context – report information (author, examining surgeon etc.) 
• Property – medical finding physical properties. 

 
Figure 120 Report dialog – context menu 

In the Report dialog it is possible to move the paragraphs up and down within the 
levels using  and  Move section up/down icons (container, text, etc.). 

Click at the  Delete section icon to delete a paragraph. A dialog will be opened, 
press the OK button to delete the paragraph from the report (see Figure 121). 

 
Figure 121 Are you sure you want to delete selected section? dialog 

The reports have three statuses: 
• Partial – open to editing, 
• Complete, 
• Verified (who verified + organisation). 

Click at the  Complete report icon to finish editing the report. It is possible to add 
a note to the report in the Complete report dialog before closing the report (see 
Figure 122). The dialog will be opened after clicking at the  icon. When clicking at 
the Cancel button or the cross at the right top corner of the dialog, the report will be 
closed without saving the changes. After pressing the OK button, the report will be 
closed and it is not possible to edit it. 
Click at the  Verify report icon, the Verify report will be opened (see Figure 
122). Fill in the name and the organisation of the verifying person. Reports can be 
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verified by more persons. The data about verifying persons will be displayed when 
viewing reports. 

  
Figure 122 Complete report and Verify report dialog 

3.22.2  View report 
Click at the  View report icon in the Reports dialog or click with the right mouse 
button at the report and choose the  icon. The report will be opened. The report 
heading (see Figure 123) contains following information: 

• Patient – name, date of birth and other predefined identification data, 
• Manufacturer, 
• Completion flag – report status (partial, complete, verified), 
• Predecessor Docs – link to the original document, 
• Verification Flag – report verification (verified, unverified),  
• Content Date/Time – date and time of creating the document. When editing 

a partial document, the time does not change, the date and time of the primary 
document is displayed. 

 
Figure 123 Report heading 

 
Figure 124 “Could not find referenced image” dialog 

If there is a link to a patient image in the report, click at the link to display the image 
in the current view. When the study with this image is not opened in TomoCon a 
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dialog will be opened informing that the referenced image can not be found (see 
Figure 124). 

It is also possible to copy the report text to the clipboard or to a text file (MS Word for 
example). Using the mouse or keyboard shortcut Ctrl+A select the text, press Ctrl+C 
to copy and Ctrl+V to insert the text into the document. 

Open a report and press Ctrl+P keys. A standard MS Windows dialog for print will be 
opened. Using the Print dialog the report can be printed on a standard MS Windows 
printer. 

Click at the  button at the right top corner of the dialog or press Esc keyboard to 
close the report. 

3.22.3  Edit a report 
Choose a report from the Reports... and click at the  Edit report icon to edit the 
existing report. Partial documents can be edited anytime. When editing a complete 
and verified document a new report will be created with identical contents. Before 
editing a dialog will be open informing about creating a revised version (see Figure 
125). 

 
Figure 125 “Only partial reports can be edited. Do you want to create revised version?” 

dialog 

The original document will not change and in the heading of the revised version a link 
to the original document will be added (Predecessor Docs). When the original report 
was not loaded into the application, it is not possible to open it. 

3.22.4  Save a report 
Open the Study menu and choose Save to save the report. When closing TomoCon a 
dialog will be opened allowing you to save unsaved changes. 

3.22.5  Delete a report 

Choose a report in the Reports... and click at the  Delete report icon or choose 
Delete in the context menu. A dialog will be opened allowing you to delete the report. 
Click at the Yes button to delete the report from the Reports... list. 
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3.23 Study anonymization  
 

This functionality is not available on MS Windows 98 SE. 
 

TomoCon allows to save the series of all opened studies as a new anonymized study 
to the Local studies. Use the Anonymize study dialog (see Figure 126) that will be 
opened after clicking at Anonymize study... in the Study menu. 

 
Figure 126 Anonymize study dialog 

The items in the dialog are filled with DICOM data received from the first opened 
study. Click at the checkbox next to the item you want to change. This will allow you 
to write in the text box of the item. Press the OK button to save the new anonymized 
study. Follow the saving process in the Anonymize study... dialog (see Figure 127). 

 
Figure 127 Saving anonymized study … dialog 
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3.24 Export image data 
TomoCon offers to export the image patient data to the following formats: 

• JPEG, DICOM, TIFF, BMP (see 3.24.1 Export images), 
• AVI (see 3.24.2 Export images to AVI format video file). 

3.24.1  Export images 
 Export image to DICOM file format is not available on MS Windows 

98 SE. 
 

It is possible to export a selected patient image (or the whole series of patient images) 
into bitmap file or DICOM file. The Export dialog can be opened by clicking at the 
Export images… submenu in the Study menu (see Figure 128). 

Available bitmap file formats are: JPEG, BMP, TIFF, and DICOM. Select an 
appropriate Image dimensions for the bitmap file or Use the original image 
dimensions supplied by the dialog. 

 
Figure 128 Export images dialog 

3.24.2  Export images to AVI format video file 
Sometimes it might be useful to create a video file from a series of patient image data 
to play back the data on another computer. 

The Create AVI dialog (see Figure 129) will be opened by clicking at the Export as 
AVI video… submenu in the Study menu. 

The Create AVI dialog allows to define: 

• Compression – current series video compression of any available type to 
create an AVI format video file. Please keep in mind that the used codec (or an 
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equivalent one) should be available on another computer to play back the 
video file, otherwise it will not be possible to play back the file; 

• Dimensions – image dimensions, 

• Frame rate – playback speed. 

You can also keep the defaults values supplied by the dialog. 

 
Figure 129 Create AVI dialog 
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3.25 Save a patient study 
To preserve changes made on the opened study of patient (defined ROIs, registrations, 
description texts) save the patient data prior to closing the patient or exiting the 
application. (Note: it is not possible to save patient data in demonstration versions of 
TomoCon and in the TomoCon Lite viewer.)  

Study changes can be saved by clicking at the Save button in the Study menu. 

Wait a moment while saving the data. Depending on amount of data to be saved it can 
take few seconds to half a minute. The Please wait… dialog (see Figure 130) will 
inform you about the ongoing progress. 

 
Figure 130 Saving modified study data in progress… 

3.26 Close a patient study 
Open DICOM studies can be closed by clicking at the  Close studies icon in the 
Standard toolbar or at the Close submenu in the Study menu. When closing the study 
a dialog will be opened (see Figure 131) allowing you to save unsaved changes (ROIs, 
registrations, annotations). 

 
Figure 131 ”Do you want to save changes?” dialog 
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3.27 Archive patient studies on CD 
 

This functionality is not available on MS Windows 98 SE. 
 

Patient studies in TomoCon can be archived on a CD medium using the Create CD 
dialog. To write this data on a CD is necessary to meet one of the following requests: 

• operating system Microsoft Windows XP with started “IMAPI CD-

Burning COM” service, 

• installed Nero Burning ROM 6.3 or higher, 

• installed Pinnacle Instant CD 8.0 or higher. 

In case that the system doesn’t meet any of these requirements, the data can be 
archived to the chosen directory on the disk.  

The Create CD… dialog (see Figure 132) will be opened by clicking at the Create 
CD… submenu in the Study menu. The Create CD… dialog will display the set of 
patient data prepared for backup at the CD. Press the Add button to add the currently 
opened studies to the prepared data set. To remove a study, series or an image from 
the set press the Remove button or Delete button on the keyboard. After pressing the 
Remove all button all studies from the prepared data set will be removed. 

 

Size of studies ready to 
burn 

List of studies ready to 
burn Add loaded studies 

Remove selected study/series
Remove all studies 

Figure 132 Create CD dialog 

Press the Create CD button to write the prepared data set onto a CD or to the chosen 
directory on the disk (depending on the Disc recorder settings). 

The Create CD dialog will be closed after pressing the Close button; the created data 
set will be kept for archiving. When re-opening the dialog (e.g. when loading new 
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patients to the application), the set will be available and new studies can be added by 
pressing the Add button. 

It is possible to add patient studies to a CD with already archived patient data. The 
Create CD dialog will display the newly added studies/series with the already 
archived studies. It is not possible to remove them (see Figure 133).  

 
Already archived patients 

Already archived series 

Series ready for archiving 

Patient ready for archiving 

 
Figure 133 Create CD dialog (add a study/series to the CD) 

Press the Create CD button to start the archiving process. Process of burning will be 
displayed in dialog (see Figure 134).  

                            
 (a) (b) 

Figure 134 Archive patient image data in progress, (a) IMAPI CD-Burning COM, (b) 
Nero Burning ROM 

Press the Options… button to specify the archiving settings. The Create CD options 
dialog will be opened (see Figure 135). 
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Figure 135 Create CD options dialog 

The following settings are available: 

• Disc recorders - select one of the available type of burning and select Disc 
recorders to be used for archiving, 

• Maximal CD capacity – user specified CD capacity, 

• Temp directory – created automatically in the user’s temporary disk region 
for temporal archiving, 

• Include – image data format to be archived: 

o If JPEG images are to be copied, the archive will contain html file 
structure similar to the archived patient-series-images structure (to allow 
simple viewing). Microsoft Internet Explorer is required to display the 
archive, 

o If DICOM images are to be copied, TomoCon Lite viewer will be added to 
the archive. It contains full TomoCon functionality except the data import. 
Only the DICOM image archive on the CD can be viewed with it. 

To create and print the cover for the created CD use the CD cover dialog (see Figure 
136). Press the CD cover… button to open the dialog. The list of the patients from the 
Create CD dialog will be automatically added to the front and the back page of the 
cover. 

Following settings are available in the CD cover dialog: 

• Print Setup tab: 

o Type of CD cover: 

 Classic cover, 

 Slim cover, 

o Margins, 
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• Front page tab: 

o Setting up the picture that will be laid behind the text on the front page 
(Bitmap). Press the Change button to choose a picture and click at the 
check box to print the picture on the front page; 

o Setting up the Title. Use the Change font button to change the font size 
and type for the title. Click at the check box to print the title on the front 
page; 

• Back page tab – the settings are the same as the front page settings. 

Press the Print button to print the CD cover. A standard MS Windows dialog for print 
will be opened (the Print dialog). Select a printer, specify parameters for print and 
press the OK button to start printing. 

  
 (a) (b) 

Figure 136 CD Cover dialog, Print setup tab (a), Front page and Back page tabs (b)
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4 Contact 

If you have any questions or comments, please contact our headquarters: 

 

TatraMed s.r.o.  
Líščie údolie 7 
841 04 Bratislava 
Slovak Republic 
 

Tel: +421 2 60202301 
 +421 2 60202391 (hotline support, local working days 8:00-16:00) 
Fax: +421 2 60202352 
E-mail: info@tatramed.com 
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6 Glossary 

• Context mouse button – mouse button with specified action - context menu, 

• DRR –  Digitally Reconstructed Radiograph, 

• DSA (Digital Subtraction Angiography) – display multi-frame XA images with 
highlighted difference between scans taken without and with the contrast media, 

• Frame of reference – relationship between two series (registration) loaded from 
the patient image data, 

• Fps (frame per second) – number of frames per second, 

• Landmark – orientation point for defining Landmark registration, 

• Level – parameters for gray level settings (view position), 

• Local studies – local storage for TomoCon application studies, 

• MIR – Mutual Information Registration, probability method for registration, 

• MPR (Multi Planar Reformatting) – display patient image date in various MPR 
planes, 

• Multi-frame image – patient image consisting of more images / slices (e.g. angio 
XA), 

• Online MPR – MPR plane current point,  

• PACS – Picture Archiving and Communication Systems, 

• Pixel – (picture element) the smallest discrete component of a digital image, 

• Primary mouse button – mouse button with specified action - Primary action, 

• Registration – relationship between two series, 

• ROI (Region of Interest) – 2D defined area in the image, 

• Segmentation – the features of interest separation (identifying) from the 
background, 

• Series – set of patient images taken in unchanged device settings and patient 
position, 

• Shape – parameters for gray level settings, 

• Status bar – a row located at the bottom of the main application window, 

• Study – set of one patient series,  

• Thumbnail preview – minimized patient image in the thumbnail palette, 
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• Thumbnail palette – a part of the application window where all opened studies 
are displayed, 

• Window – parameters for gray level settings (view width), 

• Working area – a part of main window for patient image data handling, 

• 3D – three-dimensional,  

• 2D – two-dimensional. 
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